Oracle® Retail Fiscal Management User Guide, Release 13.2.5
E37588-01

Copyright © 2012, Oracle and/or its affiliates. All rights reserved.

Primary Author: Seema Kamat

This software and related documentation are provided under a license agreement containing restrictions on use and disclosure and are protected by intellectual property laws. Except as expressly permitted in your license agreement or allowed by law, you may not use, copy, reproduce, translate, broadcast, modify, license, transmit, distribute, exhibit, perform, publish, or display any part, in any form, or by any means. Reverse engineering, disassembly, or decompilation of this software, unless required by law for interoperability, is prohibited.

The information contained herein is subject to change without notice and is not warranted to be error-free. If you find any errors, please report them to us in writing.

If this software or related documentation is delivered to the U.S. Government or anyone licensing it on behalf of the U.S. Government, the following notice is applicable:

U.S. GOVERNMENT END USERS: Oracle programs, including any operating system, integrated software, any programs installed on the hardware, and/or documentation, delivered to U.S. Government end users are “commercial computer software” pursuant to the applicable Federal Acquisition Regulation and agency-specific supplemental regulations. As such, use, duplication, disclosure, modification, and adaptation of the programs, including any operating system, integrated software, any programs installed on the hardware, and/or documentation, shall be subject to license terms and license restrictions applicable to the programs. No other rights are granted to the U.S. Government.

This software or hardware is developed for general use in a variety of information management applications. It is not developed or intended for use in any inherently dangerous applications, including applications that may create a risk of personal injury. If you use this software or hardware in dangerous applications, then you shall be responsible to take all appropriate fail-safe, backup, redundancy, and other measures to ensure its safe use. Oracle Corporation and its affiliates disclaim any liability for any damages caused by use of this software or hardware in dangerous applications.

Oracle and Java are registered trademarks of Oracle and/or its affiliates. Other names may be trademarks of their respective owners.

Intel and Intel Xeon are trademarks or registered trademarks of Intel Corporation. All SPARC trademarks are used under license and are trademarks or registered trademarks of SPARC International, Inc. AMD, Opteron, the AMD logo, and the AMD Opteron logo are trademarks or registered trademarks of Advanced Micro Devices. UNIX is a registered trademark of The Open Group.

This software or hardware and documentation may provide access to or information on content, products, and services from third parties. Oracle Corporation and its affiliates are not responsible for and expressly disclaim all warranties of any kind with respect to third-party content, products, and services. Oracle Corporation and its affiliates will not be responsible for any loss, costs, or damages incurred due to your access to or use of third-party content, products, or services.

Value-Added Reseller (VAR) Language

Oracle Retail VAR Applications

The following restrictions and provisions only apply to the programs referred to in this section and licensed to you. You acknowledge that the programs may contain third party software (VAR applications) licensed to Oracle. Depending upon your product and its version number, the VAR applications may include:

(i) the MicroStrategy Components developed and licensed by MicroStrategy Services Corporation (MicroStrategy) of McLean, Virginia to Oracle and imbedded in the MicroStrategy for Oracle Retail Data Warehouse and MicroStrategy for Oracle Retail Planning & Optimization applications.

(ii) the Wavelink component developed and licensed by Wavelink Corporation (Wavelink) of Kirkland, Washington, to Oracle and imbedded in Oracle Retail Mobile Store Inventory Management.

(iii) the software component known as Access Via™ licensed by Access Via of Seattle, Washington, and imbedded in Oracle Retail Signs and Oracle Retail Labels and Tags.

(iv) the software component known as Adobe Flex™ licensed by Adobe Systems Incorporated of San Jose, California, and imbedded in Oracle Retail Promotion Planning & Optimization application.

You acknowledge and confirm that Oracle grants you use of only the object code of the VAR Applications. Oracle will not deliver source code to the VAR Applications to you. Notwithstanding any other term or condition of the agreement and this ordering document, you shall not cause or permit alteration of any VAR Applications. For purposes of this section, “alteration” refers to all alterations, translations, upgrades, enhancements, customizations or modifications of all or any portion of the VAR Applications including all reconfigurations, reassembly or reverse assembly, re-engineering or reverse engineering and recompiations or reverse compilations of the VAR Applications or any derivatives of the VAR Applications. You
acknowledge that it shall be a breach of the agreement to utilize the relationship, and/or confidential information of the VAR Applications for purposes of competitive discovery.

The VAR Applications contain trade secrets of Oracle and Oracle’s licensors and Customer shall not attempt, cause, or permit the alteration, decompilation, reverse engineering, disassembly or other reduction of the VAR Applications to a human perceivable form. Oracle reserves the right to replace, with functional equivalent software, any of the VAR Applications in future releases of the applicable program.
# Contents

## Send Us Your Comments
Send Us Your Comments........................................................................................................................ ix

## Preface
Preface................................................................................................................................................................ xi

  Audience ........................................................................................................................................................... xi
  Documentation Accessibility ........................................................................................................................ xi
  Related Documents ........................................................................................................................................ xii
  Customer Support ......................................................................................................................................... xii
  Review Patch Documentation ................................................................................................................ xiii
  Oracle Retail Documentation on the Oracle Technology Network ......................................................... xiii
  Conventions .................................................................................................................................................. xiii

## 1 Overview

**Brazil Localization Overview**................................................................................................................... 1-1
  Nota Fiscal.................................................................................................................................................. 1-1

**About Oracle Retail Fiscal Management** ................................................................................................ 1-1

**Business Processes** ................................................................................................................................ 1-2
  Discrepancy Identification and Resolution Process .................................................................................. 1-2

## 2 Foundation Data

**Foundation Data Setup** ............................................................................................................................ 2-1
  Requisition Types ...................................................................................................................................... 2-1
  Nature of Operation.................................................................................................................................... 2-2
  Mode ............................................................................................................................................................ 2-2
  Utilization Code Maintenance .................................................................................................................. 2-2
    Adding Utilization Code ......................................................................................................................... 2-2
    Deleting Utilization Code ...................................................................................................................... 2-3
  Fiscal Utilization Options ....................................................................................................................... 2-4
    Doc Type ................................................................................................................................................ 2-4
      Adding Doc Type ................................................................................................................................. 2-4
      Deleting Doc Type .............................................................................................................................. 2-5
    Parameters ............................................................................................................................................. 2-5
    Reason Code ......................................................................................................................................... 2-6
  Fiscal Document Types Maintenance ....................................................................................................... 2-7
    Fiscal Doc Type .................................................................................................................................... 2-8
  System Options ......................................................................................................................................... 2-9
Purge System Options ................................................................. 2-9
Discrepancy System Options .................................................. 2-10
Fiscal Management System Options ..................................... 2-10
Setting Up System Options ................................................... 2-13
Tolerance Parameter ............................................................... 2-14
Setting up Tolerances ............................................................ 2-14
Location Fiscal Numbers ....................................................... 2-16
Adding Fiscal Numbers .......................................................... 2-16
Deleting Fiscal Numbers ....................................................... 2-17
Viewing Fiscal Numbers ....................................................... 2-18

3 Purchase Order

Business Flow .............................................................................. 3-1
NF Processing - PO Receiving .................................................. 3-2
Viewing the Error Log ............................................................... 3-17
NF Processing - Link and Delink .............................................. 3-18
Linking an NF to a Schedule .................................................... 3-18
Delinking an NF and a Schedule ............................................. 3-19
Discrepancy Resolution .......................................................... 3-20
User Interface Indicators for Discrepancy ......................... 3-21
Centralized Resolution Discrepancy Process .................... 3-22
Quantity Discrepancy ............................................................. 3-22
Return NF and Merchandise without NF Report Generation 3-24
De-centralized Discrepancy Resolution Process ................ 3-25
Cost Discrepancy ................................................................. 3-25
Printing Correction Documents ............................................ 3-27
Tax Discrepancy .................................................................... 3-28
Complementary NF ............................................................... 3-31
Complementary NF for Triangulation .................................. 3-32
Complementary NF Processing for Triangulation ............... 3-32
Complementary NF for Non-Merchandise Cost .................. 3-33
Complementary NF Processing for Non-Merchandise Cost 3-33
Complementary NF for Cost/Tax Correction ....................... 3-34
Complementary NF Processing for Cost/Tax Correction .... 3-35
Deal Income Posting .............................................................. 3-36
Deal Types ............................................................................ 3-36

4 Return to Vendor

Business Flow ......................................................................... 4-1
NF Processing for RTV ........................................................... 4-2

5 Inventory Control

Transfers ................................................................................ 5-1
Business Flow ......................................................................... 5-1
Transfer Creation in RMS ...................................................... 5-1
Transfer Shipment at Warehouse ......................................... 5-2
Send Us Your Comments

Oracle® Retail Fiscal Management User Guide, Release 13.2.5

Oracle welcomes customers’ comments and suggestions on the quality and usefulness of this document.

Your feedback is important, and helps us to best meet your needs as a user of our products. For example:

- Are the implementation steps correct and complete?
- Did you understand the context of the procedures?
- Did you find any errors in the information?
- Does the structure of the information help you with your tasks?
- Do you need different information or graphics? If so, where, and in what format?
- Are the examples correct? Do you need more examples?

If you find any errors or have any other suggestions for improvement, then please tell us your name, the name of the company who has licensed our products, the title and part number of the documentation and the chapter, section, and page number (if available).

Note: Before sending us your comments, you might like to check that you have the latest version of the document and if any concerns are already addressed. To do this, access the Online Documentation available on the Oracle Technology Network Web site. It contains the most current Documentation Library plus all documents revised or released recently.

Send your comments to us using the electronic mail address: retail-doc_us@oracle.com

Please give your name, address, electronic mail address, and telephone number (optional).

If you need assistance with Oracle software, then please contact your support representative or Oracle Support Services.

If you require training or instruction in using Oracle software, then please contact your Oracle local office and inquire about our Oracle University offerings. A list of Oracle offices is available on our Web site at http://www.oracle.com.
Preface

The Oracle Retail Fiscal Management (ORFM) User Guide explains the new fiscal management module that handles the fiscal operations and requirements of the Brazilian fiscal system.

This guide describes the ORFM user interface. It provides step-by-step instructions to complete most tasks that can be performed through the user interface.

Audience

This User Guide is for users and administrators of Oracle Retail Product. This includes merchandisers, buyers, business analysts, and administrative personnel.

Documentation Accessibility

Our goal is to make Oracle products, services, and supporting documentation accessible to all users, including users that are disabled. To that end, our documentation includes features that make information available to users of assistive technology. This documentation is available in HTML format, and contains markup to facilitate access by the disabled community. Accessibility standards will continue to evolve over time, and Oracle is actively engaged with other market-leading technology vendors to address technical obstacles so that our documentation can be accessible to all of our customers. For information about Oracle’s commitment to accessibility, visit the Oracle Accessibility Program website at http://www.oracle.com/accessibility/.

Accessibility of Code Examples in Documentation

Screen readers may not always correctly read the code examples in this document. The conventions for writing code require that closing braces should appear on an otherwise empty line; however, some screen readers may not always read a line of text that consists solely of a bracket or brace.

Accessibility of Links to External Web Sites in Documentation

This documentation may contain links to Web sites of other companies or organizations that Oracle does not own or control. Oracle neither evaluates nor makes any representations regarding the accessibility of these Web sites.

Access to Oracle Support

Oracle customers have access to electronic support through My Oracle Support. For information, visit http://www.oracle.com/support/contact.html or visit...
Related Documents

For more information, see the following documents in the Oracle Retail Fiscal Management Release 13.2.5 documentation set:

- Oracle® Retail Merchandising System (RMS) Installation Guide
- Oracle® Retail Fiscal Management and Brazil Localization Installation Guide
- Oracle® Retail Merchandising System (RMS) Operations Guide
- Oracle® Retail POS Suite 13.3.5/Merchandising Operations Management 13.2.5 Implementation Guide
- Oracle® Retail Fiscal Management and Brazil Localization Implementation Guide
- Oracle® Retail Merchandising System (RMS) User Guide and Online Help
- Oracle® Retail Sales Audit (ReSA) User Guide and Online Help
- Oracle® Retail Merchandising System (RMS) Data Model
- Oracle® Retail Fiscal Management (ORFM) Data Model
- Oracle® Retail Merchandising System with Brazil Localization Release Notes
- Oracle® Retail Merchandising Batch Schedule
- Oracle® Retail Merchandising Implementation Guide

Supplemental Documentation at My Oracle Support list:

- Oracle® Retail Fiscal Management/RMS Brazil Localization - Multi-currency Operations - White Paper, Release 13.2.5 (ID 1493604.1)
- Oracle® Retail Fiscal Management/RMS Brazil Localization - Enterprise Business Suite (EBS) Integration - White Paper, Release 13.2.5 (ID 1493605.1)
- Oracle® Retail Fiscal Management/RMS Brazil Localization - Transfer Price Nota Fiscal - White Paper, Release 13.2.5 (ID 1493606.1)

Also see the documentation library for Oracle Business Intelligence Enterprise Edition at this URL:

http://www.oracle.com/technology/documentation/bi_ee.html

Customer Support

To contact Oracle Customer Support, access My Oracle Support at the following URL:

https://support.oracle.com

When contacting Customer Support, please provide the following:

- Product version and program/module name
- Functional and technical description of the problem (include business impact)
- Detailed step-by-step instructions to re-create
- Exact error message received
- Screen shots of each step you take
Review Patch Documentation

When you install the application for the first time, you install either a base release (for example, 13.2) or a later patch release (for example, 13.2.4). If you are installing the base release, additional patch, and bundled hot fix releases, read the documentation for all releases that have occurred since the base release before you begin installation. Documentation for patch and bundled hot fix releases can contain critical information related to the base release, as well as information about code changes since the base release.

Oracle Retail Documentation on the Oracle Technology Network

Documentation is packaged with each Oracle Retail product release. Oracle Retail product documentation is also available on the following Web site:

http://www.oracle.com/technology/documentation/oracle_retail.html

(Data Model documents are not available through Oracle Technology Network. These documents are packaged with released code, or you can obtain them through My Oracle Support.)

Documentation should be available on this Web site within a month after a product release.

Conventions

The following text conventions are used in this document:

<table>
<thead>
<tr>
<th>Convention</th>
<th>Meaning</th>
</tr>
</thead>
<tbody>
<tr>
<td>boldface</td>
<td>Boldface type indicates graphical user interface elements associated with an action, or terms defined in text or the glossary.</td>
</tr>
<tr>
<td>italic</td>
<td>Italic type indicates book titles, emphasis, or placeholder variables for which you supply particular values.</td>
</tr>
<tr>
<td>monospace</td>
<td>Monospace type indicates commands within a paragraph, URLs, code in examples, text that appears on the screen, or text that you enter.</td>
</tr>
</tbody>
</table>
This user guide provides you information on how to effectively use the Oracle Retail Fiscal Management (ORFM) module of the Oracle Retail Merchandising System (RMS).

This chapter contains the following information:
- Brazil Localization Overview
- About Oracle Retail Fiscal Management
- Business Processes

**Brazil Localization Overview**

The movement of merchandise has to be accompanied by a fiscal document called Nota Fiscal (NF). The shipping location has to generate the NF. When the truck arrives at its destination, and before the physical receiving of the merchandise, the NF has to be validated against the Purchase Order (PO) and the Brazilian fiscal system, in order to ensure that all the taxes are applied correctly.

**Nota Fiscal**

The Nota Fiscal contains the following information:
- Transaction details, that is the items, and the quantities of items.
- Financial details, such as cost of the item.
- Taxation, and fiscal details such as tax codes, tax values, código fiscal de operações e prestações (CFOP), Cadastro Nacional de Pessoas Jurídicas (CNPJ), and other fiscal attributes used by the government to verify taxes for merchandise in transit.

The recipient of the merchandise has to ensure that the movement of merchandise is accompanied by a valid NF. In case of discrepancy, the shipment may be accepted by issuing supporting correction documents or the shipment may be rejected.

**About Oracle Retail Fiscal Management**

ORFM module enables you to verify the merchandise costs, quantities, and taxation details before payment. In ORFM, data can be entered manually or through Electronic Data Interchange (EDI). It integrates all the fiscal operations of the Brazilian fiscal system into RMS. It deals with creation of, and the receiving process of Nota Fiscals (NF), in addition to the issuing and printing of NF.
Business Processes

ORFM supports the following fiscal business operations:

- **PO Receiving** – This is the regular buying process of a retailer. The retailer issues a purchase order (PO) when buying the merchandise from a supplier. When the merchandise is received, this merchandise is matched against the related PO in order to verify that the receiving merchandise has the items that the retailer has bought from the supplier. The retailer issues a PO when buying the merchandise from a supplier.

In case of discrepancies, the ORFM application supports resolving the cost, quantity, and tax discrepancy. For more information on how the application resolves the discrepancies, refer to the Discrepancy Identification and Resolution Process.

- **Transfers** – Transfer is the movement of merchandise from one location to another, either a warehouse or a store. When the transfer is issued, ORFM creates and issues the related NF (based on the transfer information) for the merchandise to be transferred out. After the merchandise is shipped and received in the other location, another inbound NF is created to receive the merchandise in the receiving location.

- **Return to Vendor (RTV)** – This business process needs the creation and issue of a NF in order to return the merchandise to the supplier. The ORFM application issues a NF for the merchandise to be sent back to the supplier.

- **Return from customers or Return Merchandise Authorization (RMA)** – When customer returns merchandise, the retailer issues a RMA in order to receive the merchandise in the store. Since this operation involves the movement of merchandise, a NF has to be issued to receive it.

- **Triangulation Purchase Order** – Triangulation is a process where in the retailer creates the PO with the main supplier to whom the payment is made. However, another supplier (a distributor or facilitator) actually delivers the stock on behalf of the main supplier (referred to as the delivery supplier).

- **NF-e Processing** – Nota Fiscal Eletrônica (NF-e) or Electronic Fiscal Note is a project initiated by the Government of Brazil. The main objective is to replace the current system of issuing fiscal documents in paper with the electronic fiscal document.

**Discrepancy Identification and Resolution Process**

In the inbound PO process, additional validations and matching of quantity, tax, and cost have to be carried out before physical receiving of merchandising occurs. The retailer has to validate the correctness of the NF before approving the physical receipt. If there are any discrepancies in the quantity, tax, or cost, these have to be resolved before physical receipt of the merchandise can occur.

The overall discrepancy identification, and resolution process can be further divided into the following sub-processes:

- **Validation Process** – The validation process includes validating the NF for errors like incorrect CFOP, header totals, etc. If there are errors on the NF, it is logged in the Error Log window. The NF has to be manually edited to resolve these errors, and the NF has to be re-validated. The validation process has the following three steps:
– Data Integrity Validation – In this process, all the NF totals are matched with the unit cost and quantity entered. This process takes into account the line item level and header level discounts, non-merchandise cost, insurance, miscellaneous expenses, and taxes while comparing the totals. If the data integrity validation fails, the NF will be in Error status. The NF has to be modified and re-validated before proceeding further.

– TaxWeb Tax Rules Call for Tax Breakup – A call is made to the TaxWeb Tax Rules engine for comparing the taxes on NF with system calculated taxes. The taxes returned by TaxWeb Tax Rules are stored at the individual item level. In case of any error during the TaxWeb Tax Rules call, status of the NF is changed to Error, and it has to be validated again.

– Discrepancy Identification – In this process, the unit cost of each item, quantity for each item and the taxes on the NF are compared with the corresponding values in the system. Any discrepancy identified during this process, the discrepancy indicators are marked appropriately on the NF header.

- Discrepancy Identification Process – After validation, the discrepancy identification process is triggered. The quantity or cost discrepancy between the purchase order and NF, and tax discrepancy on the NF and the tax returned by TaxWeb Tax Rules is identified during this process. For tax discrepancy, the ORFM application validates that the NF has used the correct tax rules to calculate the taxes.

- Discrepancy Resolution Process – Any discrepancies identified during the discrepancy identification process are available in the Discrepancy Resolution window. These discrepancies have to be resolved manually. In a centralized operation it is mandatory to resolve quantity discrepancies in order to proceed with physical receiving. In case of a de-centralized operation it is mandatory to resolve all discrepancies (cost, quantity and tax) in order to proceed with physical receiving.

- Generation of Return NF, and Merchandise without NF Report – If the NF quantity is greater than the Open PO quantity, a return NF is generated, which is for the supplier to take back the excess stock. Sometimes, the merchandise is returned at the point of receipt in order to reduce shipping costs. The calculation of Return NF quantity and Merchandise without NF quantity is done after the physical receiving is done.

- Generation of Correction Letter – A correction letter is generated when the PO cost/quantity/tax is different from the NF cost/quantity/tax, and the PO cost/quantity/tax is considered to be correct. The correction letter, with the PO values as the NF values, is automatically generated after all the discrepancies are resolved, depending on the discrepancy resolution action.
ORFM has its own Foundation Data. The foundation data has to be configured for the proper functioning of the ORFM application.

This chapter covers the following sections:

- Foundation Data Setup
- System Options
- Tolerance Parameter
- Location Fiscal Numbers

### Foundation Data Setup

ORFM Foundation Data Setup includes setting up the utilization codes, related parameters, and document type codes.

### Requisition Types

Requisition Type indicates the type of transaction that ORFM supports. ORFM supports the following requisition types:

- **Purchase Order (PO)** – This Requisition Type is applicable when there is movement of merchandise from a supplier to retailer’s location.
- **Transfer (intra-company)** – This Requisition Type is applicable when there is movement of merchandise from one location to another, either a warehouse or a store.
- **Intercompany Transfer** – This Requisition Type is applicable when there is a movement of merchandise between companies.
- **Return to Vendor (RTV)** – This Requisition Type is applicable when the merchandise is returned to the vendor.
- **Repairing** – This Requisition Type is applicable when merchandise is sent out to the external finisher or the supplier for finishing work (such as printing, dyeing, and embroidery) or repair (in the case of damaged goods).
- **Return Merchandise Authorization (RMA)** – This Requisition Type enables the retailer to pick up merchandise that is being returned from the customer.
- **Inventory Adjustment** – This Requisition Type enables total stock-on-hand adjustments or unavailable inventory for one or more item/locations.
- **Direct NF** - This Requisition Type is used to distinguish StandAlone NFs from Other NFs created within ORFM.
Free Form NF - This Requisition Type is applicable when the user wishes to add generic items/services that are not present in RMS to the NF or use fiscal entities that are not defined in RMS. This is a StandAlone NF that is not related to any RMS transaction.

Nature of Operation

Nature of Operation (NOP) is a term used in TaxWeb Tax Rules. The nature of operations represents the transactions used to deduce the código fiscal de operações e prestações (CFOP) codes in tax rules. There can be more than one utilization for the same NOP. For each TaxWeb Tax Rules call to retrieve taxes, ORFM returns the NOP related to the transaction to TaxWeb Tax Rules.

Note: ORFM and RMS are integrated with TaxWeb Tax Rules to get the tax break up for the NF. TaxWeb Tax Rules requires NOP to derive the CFOP before tax calculations. Therefore, ORFM maintains the list of NOP and enables you to link utilization and NOP.

Mode

Mode indicates whether the NF is being created for inbound, or outbound operations. The possible values for Mode are Inbound (Entry), and Outbound (Exit).

Utilization Code Maintenance

All merchandise in ORFM is associated with a utilization code. This code provides information about the transaction type and the NF related to the transaction. This information is used to determine the appropriate taxes for the merchandise as well as the impact on warehouse stock and on costs.

Each utilization code is linked to a Requisition Type, a NOP, and one or more document types.

Note: The utilization parameters are not available (dimmed) for the StandAlone NF.

Adding Utilization Code

To add a Utilization Code, do the following:

Navigate: From the RMS Start Menu, select Fiscal Management, then Fiscal Configuration.

1. In the Contents Of Fiscal Configuration, select Fiscal Utilization.
2. In the Contents Of Fiscal Utilization window, click Edit. The Fiscal Utilization Setup window appears.

Note: Click View in the Contents Of Fiscal Utilization window to view the fiscal utilization codes. In the View mode, the multi-record block is non-editable, and the Add and Delete buttons are disabled.
3. On the Fiscal Utilization Setup window, click **Add**. A highlighted blank row appears.

4. Enter the Utilization Code, and Description. The Utilization Code is the unique identifier for each utilization. The Description column describes the fiscal utilization.

5. Select the Requisition Type from the list in the Req.Type column. The requisition types are: Purchase Order, Transfer, Return to Vendor, Return Merchandise Authorization, Stock Out, PO for Rural Producer, InterCompany Transfers, Repairing, Return NF, and Sales.

6. Select the Issue from the list in the Issue column. The issue types are: Issue or Include. The drop-down is enabled if the Requisition Type is either, Direct NF or Free from NF. The drop-down value of Issue indicates that the utilization code is relevant for cases wherein the Retailer is issuing the NF. When utilization codes classified as Issue are used for StandAlone NF creation, the Fiscal number, Serial, and Sub Serial Number fields are populated based on Location sequencing Logic. The drop-down value Include, indicates that the NF is issued by an external system. StandAlone NFs using utilization code classified as Include will have a mode type of entry and it allows for manual entry of the Fiscal number information.

7. Specify the Nature of Operation.

8. Enter the mode of operation. The Mode is either Entry or Exit.

**Deleting Utilization Code**

1. On the Fiscal Utilization Setup window, select the utilization you want to delete, and click **Delete**. The following message is displayed:

2. Click **Yes** to delete the utilization.
Fiscal Utilization Options

The Fiscal Utilization Options menu consists of the following items:

- Doc Type
- Parameters
- Reason Code

Doc Type

The utilization code is linked to one or more document types, and each fiscal document type has to be associated with a utilization code.

Adding Doc Type

To add Doc Type to the Utilization Code, do the following:

Navigate: From the RMS Start Menu, select Fiscal Management, then select Fiscal Configuration.

1. In the Contents Of Fiscal Configuration window, select Fiscal Utilization.
2. In the Contents Of Fiscal Utilization window, click Edit. The Fiscal Utilization Setup window appears.

3. In the Fiscal Utilization Setup window, select the Utilization Code for which Doc Types are being defined.
4. From the Options menu, select Doc Type. The Fiscal Utilization Document Type window appears.

Figure 2–3 Fiscal Utilization Document Type Window

5. Click Add. A highlighted blank row is displayed.
6. From the Doc Type ID LOV, select the value.
7. Click OK to exit the window.

Deleting Doc Type

To delete document types, do the following in the Fiscal Utilization - Document Type window:

1. Select the doc type that you want to delete. Click Delete in the Fiscal Utilization - Document Type window.
   A message appears. Click Yes to delete the document type.

2. Click OK to exit the window.

Parameters

Parameters are defined for each of the utilization codes.

To associate the parameters with the utilization codes, do the following:

Navigate: From the RMS Start Menu, select Fiscal Management, then select Fiscal Configuration.

In the Contents Of Fiscal Utilization, select Edit. The Fiscal Utilization Setup window appears.

1. On the Fiscal Utilization Setup window, click the Options menu.

2. Select Parameters. The Fiscal Utilization Attributes window appears.

Figure 2–4  Fiscal Utilization Attributes Window

3. Select or deselect the check boxes to configure the parameters for every Utilization Code.

Table 2-1 provides the list of parameters, and their description.

Table 2–1 Parameters of Fiscal Utilization Attributes

<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Complementary NF</td>
<td>When you select the Complementary NF check box, the Complementary NF Type list is enabled.</td>
</tr>
<tr>
<td>Complementary NF Type</td>
<td>Choose the Complementary NF type from the Complementary NF Type list:</td>
</tr>
<tr>
<td></td>
<td>▪ Triangulation</td>
</tr>
<tr>
<td></td>
<td>▪ Non-Merchandise cost</td>
</tr>
<tr>
<td></td>
<td>▪ Cost/Tax Correction</td>
</tr>
</tbody>
</table>
Reason Code

The Reason Code is created by the retailer for inventory adjustment and repairing operations. It is used to identify returns and can be configured in the ORFM module.

Note: A utilization can have any number of Reason Codes attached to it. However, the Reason Code cannot be attached to utilization if the Reason Code is already attached to any other Utilization ID. The Reason Code LOV shows only the Reason Codes that are not attached to any type of utilization ID.

To associate Reason Code with the Utilization Code, do the following:
Navigate: From the RMS Start Menu, select Fiscal Management, then select Fiscal Configuration.

1. On the Fiscal Utilization Setup window, click the Options menu.

   **Note:** This option is enabled only if the Requisition Type selected for the Utilization Code is Inventory Adjustment (Stock).

2. Select the inventory adjustment for which you want to add the Reason Code. From the Options menu, select Reason Code. The Fiscal Utilization Reason Codes window appears.

   **Figure 2–5 Fiscal Utilization Reason Codes Window**

3. Click Add. In the highlighted row that appears, select the reason code from the list.

4. Click OK. The reason code is associated with the inventory adjustment.

To delete the reason code, do the following in the Fiscal Utilization Codes Reason Codes window:

1. Select the reason code that you want to delete. Click Delete in the Fiscal Utilization Codes Reason Codes window. A message appears. Click Yes to delete the reason code.

2. Click OK to exit the window.

**Fiscal Document Types Maintenance**

The document type codes are defined by the fiscal authorities and each NF must have a document type code at the header level.

To associate Fiscal Document Types with a Utilization Code, do the following:

Navigate: From the RMS Start Menu, select Fiscal Management, then select Fiscal Configuration.

1. In Contents Of Fiscal Configuration window, select Fiscal Document Types.

3. Select the document type from the list. The list contains the all possible Fiscal Doc Types. The list displays the Fiscal Document Type ID and Description.

4. Click Add to add a fiscal document type. A new highlighted row is displayed.

5. The Description field displays the Fiscal Document Type description.

6. Click OK to exit the window.

To delete the document type, do the following:

1. Select the document type that you want to delete. Click Delete. A confirmation message appears.

2. Click Yes to delete the document type.

3. Click OK to exit the window.

**Fiscal Doc Type**

To associate the document type with the Utilization Code, do the following:

**Navigate:** From the RMS Start Menu, select Fiscal Management, then select Fiscal Configuration.

1. Select the document type to which you want to associate a Utilization Code.

2. Click Util in the Fiscal Document Type window. The Fiscal Doc Type Utilization window appears.
3. Click **Add** in the Fiscal Doc Type Utilization window.

4. A new row appears. Select the Utilization Code from the list.

5. Click **OK** to save your changes and exit the window.

To delete the utilization, do the following:

1. To delete a utilization, select the utilization, and click **Delete**.

2. Confirm the deletion in the message that appears. Click **OK** to exit the window.

### System Options

Set up the system configuration variables using the System Setup link.

The system options can be set up for the following operations:

- Purge
- Discrepancy
- Fiscal Management

### Purge System Options

These system options decide when the purge operations have to be implemented.

<table>
<thead>
<tr>
<th>System Option</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>History Days for Worksheet Documents</td>
<td>Number of days a document in worksheet status should reside in active tables</td>
</tr>
<tr>
<td>History Days for Deleted Documents</td>
<td>Number of days a document in inactive status should reside in active tables</td>
</tr>
<tr>
<td>History Days for Completed PO Documents</td>
<td>Number of days a PO document in completed status should reside in active tables</td>
</tr>
<tr>
<td>History Days for Completed Documents Other than PO</td>
<td>Number of days a document in completed status should reside in active tables</td>
</tr>
<tr>
<td>History Days for History Tables</td>
<td>Number of days the data in history table should be maintained</td>
</tr>
</tbody>
</table>
Discrepancy System Options

These system options in ORFM decide what is the action that has to be taken for discrepancy resolution.

While resolving discrepancies, the values on the Purchase Order (PO) may be considered as correct, or the NF values may be considered as correct. In some cases, you can evaluate both the values, and decide what value to choose to resolve the discrepancy. In order to facilitate these requirements following three new system options are introduced:

<table>
<thead>
<tr>
<th>System Option</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Quantity Discrepancy Resolution Rule</td>
<td>This option can have the following values: System, Nota Fiscal and Reconcile. In case of quantity discrepancy, the system value is the PO value.</td>
</tr>
<tr>
<td>Cost Discrepancy Resolution Rule</td>
<td>This option can have the following values: System, Nota Fiscal and Reconcile. In case of cost discrepancy, the system value is the PO value.</td>
</tr>
<tr>
<td>Tax Discrepancy Resolution Rule</td>
<td>This option can have the following values: System, Nota Fiscal, and Reconcile. In case of tax discrepancy, system values are provided by TaxWeb Tax Rules.</td>
</tr>
</tbody>
</table>

Note: For more information about the usage of the system options set for discrepancy, see the Discrepancy Identification and Resolution Process below.

Fiscal Management System Options

These system options help in the successful functioning of the fiscal management module.

The system options, and their descriptions are given below.

<table>
<thead>
<tr>
<th>System Option</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>HOUR_FORMAT</td>
<td>Format to represent fields of hour</td>
</tr>
<tr>
<td>PURGE_DAYS</td>
<td>Days before records are purged from the tables</td>
</tr>
<tr>
<td>ORIGIN_CST_IND</td>
<td>Default Origin Code and CST Type for ICMS tax situation</td>
</tr>
<tr>
<td>DOC_TYPE_PO</td>
<td>Default fiscal doc type code (e.g. 1 - Nota Fiscal - Modelo 1, 1A)</td>
</tr>
<tr>
<td>PERCENT_FORMAT</td>
<td>Percentage Field Format</td>
</tr>
<tr>
<td>NUMBER_FORMAT</td>
<td>Value Field Format</td>
</tr>
<tr>
<td>DEFAULT_PO_TYPE</td>
<td>Default PO Type when null in ORMS (fiscal utilization code in the Retail Fiscal Management module)</td>
</tr>
<tr>
<td>DEFAULT_SALES_TYPE</td>
<td>Default SALES Type when null in ORMS (fiscal utilization code in the Retail Fiscal Management module)</td>
</tr>
<tr>
<td>DEFAULT_COUNTRY</td>
<td>Default supplier country</td>
</tr>
<tr>
<td>System Option</td>
<td>Description</td>
</tr>
<tr>
<td>---------------------------</td>
<td>------------------------------------------------------------------------------</td>
</tr>
<tr>
<td>DEFAULT_CURRENCY</td>
<td>Default currency code</td>
</tr>
<tr>
<td>DEFAULT_DOCUMENT_TYPE</td>
<td>Default document type used by the process to create an EDI document based on external systems</td>
</tr>
<tr>
<td>TOLERANCES_MANDATORY</td>
<td>Tolerances are applied or not</td>
</tr>
<tr>
<td>DEFAULT_FREIGHT_TYPE</td>
<td>Default freight type used by the process to create an EDI document based on external systems</td>
</tr>
<tr>
<td>QTY_FORMAT</td>
<td>Quantity Field Format</td>
</tr>
<tr>
<td>RFC_REASON</td>
<td>Return from customer reason code</td>
</tr>
<tr>
<td>ORFMI_MIN_DAYS</td>
<td>Number of days minus the ORFMI date</td>
</tr>
<tr>
<td>ORFMO_MIN_DAYS</td>
<td>Number of days minus the ORFMO date</td>
</tr>
<tr>
<td>ORFMO_MAX_DAYS</td>
<td>Number of days minus the ORFMO date</td>
</tr>
<tr>
<td>ORFMI_MAX_DAYS</td>
<td>Number of days minus the ORFMI date</td>
</tr>
<tr>
<td>EDI_DEF_PTNR_ID</td>
<td>Indicates the default partner id when importing EDI documents</td>
</tr>
<tr>
<td>EDI_DEF_PTNR_TYPE</td>
<td>Indicates the default partner type when importing EDI documents</td>
</tr>
<tr>
<td>GET_ORIGIN_DOC_TAXES</td>
<td>Requisition type for use of parameters of taxes of the origin fiscal document</td>
</tr>
<tr>
<td>CHECK_APPROVED_DOCS</td>
<td>Variable to check whether it is mandatory to approve all fiscal documents before approving the schedule</td>
</tr>
<tr>
<td>CALC_TOL_TYPE</td>
<td>The calculation tolerance type (P/V)</td>
</tr>
<tr>
<td>CALC_TOL_VALUE</td>
<td>The calculation tolerance value</td>
</tr>
<tr>
<td>QTY_RESOLUTION_RULE</td>
<td>Default Resolution Action for Quantity Discrepancies</td>
</tr>
<tr>
<td>COST_RESOLUTION_RULE</td>
<td>Default Resolution Action for Cost Discrepancies</td>
</tr>
<tr>
<td>TAX_RESOLUTION_RULE</td>
<td>Default Resolution Action for Tax Discrepancies</td>
</tr>
<tr>
<td>DEFAULT_RMA_UTIL_ID</td>
<td>Default Utilization ID for RMA</td>
</tr>
<tr>
<td>DEFAULT_RMA_DOC_TYPE</td>
<td>Default Document Type for RMA</td>
</tr>
<tr>
<td>DEFAULT_RTV_DOC_TYPE</td>
<td>Default Document Type for RTVs</td>
</tr>
<tr>
<td>DEFAULT_RTV_UTIL_ID</td>
<td>Default Utilization ID for RTVs</td>
</tr>
<tr>
<td>EDI_RTV</td>
<td>Indicates whether the requisition type for RTV is &quot;ENTRY&quot; or &quot;EXIT&quot;</td>
</tr>
<tr>
<td>DEFAULT_OUTBOUND_TSF_DOC_TYPE</td>
<td>Default Document Type for Outbound Transfers</td>
</tr>
<tr>
<td>DEFAULT_OUTBOUND_TSF_UTIL_ID</td>
<td>Default Utilization ID for Outbound Transfers</td>
</tr>
<tr>
<td>DEFAULT_INBOUND_TSF_DOC_TYPE</td>
<td>Default Document Type for Inbound Transfers</td>
</tr>
<tr>
<td>DEFAULT_INBOUND_TSF_UTIL_ID</td>
<td>Default Utilization ID for Inbound Transfers</td>
</tr>
<tr>
<td>System Option</td>
<td>Description</td>
</tr>
<tr>
<td>-------------------------------</td>
<td>-----------------------------------------------------------------------------</td>
</tr>
<tr>
<td>EDI_TSF</td>
<td>Indicates whether the requisition type for TSF is &quot;ENTRY&quot; or &quot;EXIT&quot;</td>
</tr>
<tr>
<td>DEFAULT_STOCK_DOC_TYPE</td>
<td>Default Document Type for Inventory Adjustments</td>
</tr>
<tr>
<td>EDI_STOCK</td>
<td>Indicates whether the requisition type for STOCK is &quot;ENTRY&quot; or &quot;EXIT&quot;</td>
</tr>
<tr>
<td>TOLERANCES_PRIORITY</td>
<td>Tolerances Priority is applied: All, Supplier, Location, Company</td>
</tr>
<tr>
<td>DEFAULT_RNF_UTILIZATION_ID</td>
<td>Default Utilization Id for Return NF</td>
</tr>
<tr>
<td>HISTORY_DAYS_COMPLETED_NON_POs</td>
<td>Indicates the number of days for completed docs other than POs</td>
</tr>
<tr>
<td>HISTORY_DAYS_COMPLETED_PO</td>
<td>Indicates the number of days for the completed POs</td>
</tr>
<tr>
<td>HISTORY_DAYS_DELETED_DOCS</td>
<td>Indicates the number of days for the Deleted NF docs</td>
</tr>
<tr>
<td>HISTORY_DAYS_HIST_TABLES</td>
<td>Indicates the number of days the history table can hold the records</td>
</tr>
<tr>
<td>HISTORY_DAYS_WORKSHEET_STATUS</td>
<td>Indicates the number of days the NF can be worksheet status</td>
</tr>
<tr>
<td>DEFAULT_NOP</td>
<td>Default Nature of Operation</td>
</tr>
<tr>
<td>DEFAULT_NFE_DOC_TYPE</td>
<td>Default Document Type for Nfe</td>
</tr>
<tr>
<td>RECOVERABLE_TAX_CST</td>
<td>Value related to the selected CST</td>
</tr>
<tr>
<td>DEFAULT_INBOUND_IC_DOC_TYPE</td>
<td>Default Document Type for Inbound IC Transfers</td>
</tr>
<tr>
<td>DEFAULT_INBOUND_IC_UTIL_ID</td>
<td>Default Utilization ID for Inbound IC Transfers</td>
</tr>
<tr>
<td>DEFAULT_OUTBOUND_IC_DOC_TYPE</td>
<td>Default Document Type for Outbound IC Transfers</td>
</tr>
<tr>
<td>DEFAULT_OUTBOUND_IC_UTIL_ID</td>
<td>Default Utilization ID for Outbound IC Transfers</td>
</tr>
<tr>
<td>DEFAULT_RURAL_PROD_UTILIZATION</td>
<td>Default Utilization Id for Rural Producer NF</td>
</tr>
<tr>
<td>DEFAULT_RURAL_PROD_DOC_TYPE</td>
<td>Default Document Type for Rural Producer</td>
</tr>
<tr>
<td>DEFAULT_INBOUND_REP_DOC_TYPE</td>
<td>Default Document Type for Inbound Repairing Transfers</td>
</tr>
<tr>
<td>DEFAULT_INBOUND_REP_UTIL_ID</td>
<td>Default Utilization ID for Inbound Repairing Transfers</td>
</tr>
<tr>
<td>DEFAULT_OUTBOUND_REP_DOC_TYPE</td>
<td>Default Document Type for Outbound Repairing Transfers</td>
</tr>
<tr>
<td>DEFAULT_OUTBOUND_REP_UTIL_ID</td>
<td>Default Utilization ID for Outbound Repairing Transfers</td>
</tr>
<tr>
<td>EDI_REP</td>
<td>Indicates whether the requisition type for REP is &quot;ENTRY&quot; or &quot;EXIT&quot;</td>
</tr>
</tbody>
</table>
Setting Up System Options

To set up the System Options, do the following:

**Navigate:** From the RMS Start Menu, select **Fiscal Management**, then select **System Setup**.

1. In the Contents Of System Setup window, select **System Options**.
2. In the Contents Of System Options window, click **Edit**. The System Options window appears.

![System Options Window](image)

3. Click the Variable field LOV to view the description and variables.
4. Click **Add**. A new row is displayed.

### Table 2–4 (Cont.) Fiscal Management System Options

<table>
<thead>
<tr>
<th>System Option</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>INC_DISC_EXP</td>
<td>This system option is only applicable when TSF_PURCHASE_PRICE is set as Y. That is, transfer NF cost to be considered is last purchase price and not WAC. It is used to specify inclusion (TRUE) or exclusion (FALSE) of expenses and discounts in the last purchase price.</td>
</tr>
<tr>
<td>TSF_PURCHASE_PRICE</td>
<td>It indicates whether the cost on the transfer NF generated is WAC N (No) or last purchase price Y (Yes).</td>
</tr>
<tr>
<td>DEAL_DEFAULT_UTIL</td>
<td>It is the default Utilization ID for Deals.</td>
</tr>
<tr>
<td>DEAL_DEF_FXMRH_TYPE</td>
<td>It is the default Document Type for Merchandise Fixed Deals.</td>
</tr>
<tr>
<td>DEAL_DEF_FXNMRH_TYPE</td>
<td>It is the default Document Type for Non-merchandise Fixed Deals.</td>
</tr>
<tr>
<td>DEAL_DEF_CMPLX_TYPE</td>
<td>It is default Document Type for Complex Deals.</td>
</tr>
</tbody>
</table>
5. Enter the details in the Variable and Description fields.
6. Select the Type from the list.
7. Enter the details in the Value field.
8. Click OK to exit the window.

**Tolerance Parameter**

Tolerance is the variance allowed between a NF and the requisition document, and also within a NF. If the NF is within tolerances, then the NF can be considered matched (without discrepancy). ORFM supports the following three types of tolerances:

- **Cost Tolerance**: Use it when comparing the unit cost of the item on the PO as against the unit cost of the item on the NF.
- **Quantity Tolerance**: Use it when matching the quantity ordered, against the quantity provided in NF for each item.
- **Calculation Tolerance**: Use it to avoid the NFs from going into discrepancies due to rounding or truncation issues.

**Note**: The cost, and quantity tolerances can be set in the Tolerance Maintenance screen of the ORFM, and calculation can be set as a system variable.

**Setting up Tolerances**

To set up the tolerances, do the following:

**Navigate**: From the RMS Start Menu, select Fiscal Management, then select System Setup.

1. In the Contents Of System Setup window, select **Tolerances**.
2. In the Contents Of Tolerances window, click **Edit**. The Tolerances window appears.
3. In the Tolerances window, the list in the Level field has two values – Supplier, and Company. Select the level applicable.

4. The Name field displays the list of all the Supplier names or Company names based on the level selected. Select the supplier, or the company name.

5. Click **Search**. The existing tolerances for the supplier or company is displayed in the multi-record block. If there are no tolerances for the selected level, the following message is displayed: "Query caused no records to be retrieved".

6. If there are tolerances for the selected values, the following parameters are displayed in the multi-record block:
   - **Tolerance Level** – Choose from Line Quantity, and Line Cost.
   - **Lower Limit Inclusive** – The lower limit for the range. This value is included in the range.
   - **Upper Limit Exclusive** – The upper limit for the range. This value is excluded from the range.
   - **Tolerance Type** – Select the Requisition Document Tolerance Type from the list. The list includes Percentage or Value.
   - **Tolerance Value** – Enter the tolerance value for matching between the NF and the requisition document of the NF.

7. Click **OK** to save the changes.

The other options available on the window includes:
   - Click **Add** to add a new row in the multi-record block.
   - Click **Delete** to delete the selected row from the multi-record block.
   - Click **Refresh** to clear the filter criteria, and the data in the multi-record block.
   - Click **Cancel** if you do not want to save the changes that you have entered.
Location Fiscal Numbers

Location Fiscal Numbers are numbers assigned to a store/warehouse. In Brazil, the sequence of NF document numbers are controlled and should be correctly followed during the NF issuing process.

Each location controls its own sequence based on the following fields:

- Documentation Type
- Serial/Sub-serial
- Sequence
- Effective Date

Any transaction that involves that particular store/warehouse should contain the fiscal numbers falling within a particular range.

Adding Fiscal Numbers

To add fiscal numbers, do the following:

**Navigate:** From the RMS Start Menu, select Fiscal Management, then System Setup. From System Setup, select Fiscal Numbers.

1. In the Contents Of Fiscal Numbers window, click **Edit.** The Location Fiscal Numbers window appears.

   **Figure 2–10  Location Fiscal Numbers Window**

   ![Location Fiscal Numbers Window](image)

   2. To add a number, select the store/warehouse from the Location LOV. Click **Add.**

      In the multi-record block, a row is highlighted as shown.
3. Assign values to Location, Document Type, Series Number, Subseries Number, Minimum Fiscal Number, Maximum Fiscal Number, and Effective Date.

Deleting Fiscal Numbers

1. Select the row that you want to delete in the Location Fiscal Numbers window.

2. Click Delete. The following message appears:

3. Click Yes to delete the row.
Viewing Fiscal Numbers

1. In the Contents Of Fiscal Numbers window, click View. The Location Fiscal Numbers window appears.

2. Select the location type from the Location Type list. The Location field is highlighted after selecting the location type.

3. Select the location from the Location LOV.

4. Click the filter icon. Based on the filter criteria, the multi-record block displays the Location Type, the Location, and the values associated with the Document Type, Series Number, Subseries Number, Minimum Fiscal Number, Maximum Fiscal Number, and Effective Date.
Purchase Order (PO) is the regular buying process of a retailer. The retailer issues a PO when buying the merchandise from a supplier. When the merchandise is received, this merchandise is matched against the related PO in order to verify that the receiving merchandise has the items that the retailer has bought to the supplier.

This chapter covers the following sections:

- Business Flow
- NF Processing - PO Receiving
- NF Processing - Link and Delink
- Discrepancy Resolution
- Complementary NF
- Complementary NF for Triangulation
- Complementary NF for Non-Merchandise Cost
- Complementary NF for Cost/Tax Correction
- Deal Income Posting
- Deal Types

**Business Flow**

The business flow for PO receiving is as follows:

1. Enter the Nota Fiscal (NF) in the Retail Fiscal Management (ORFM) module.
2. When the shipment arrives at the warehouse or the store, create a schedule and enter the NFs received.

   **Note:** You can link more than one NF to a schedule.
   The schedule can be created before or after creating an NF.
   An NF can be created without a schedule, but they have to be linked before submitting for receiving.

3. After NF entry, validate the NFs. In the validation process, the ORFM application checks for data integrity. Match the NF with the requisition documents in the Retail Merchandising System (RMS). This process is called as the Fiscal Receiving.
If the NF and the PO does not match, the NF is in discrepancy. You can identify the following discrepancies with the ORFM application:

- Unit Cost Discrepancy for each item in the NF
- Quantity Discrepancy for each item in the NF
- Tax Discrepancy happens between system (tax details from TaxWeb Tax Rules) and NF.

4. After validation, send the schedule to the warehouse management system and store inventory management system. After physical receiving, both the systems publish the receipt updates to ORFM. This completes the NF processing.

5. Send the transaction data in RMS and ORFM to a financial application. For fiscal reporting purposes, send the NF data in ORFM to the fiscal reporting system like SPED.

**NF Processing - PO Receiving**

The Receiving/Issuing module of ORFM enables you to create the required NF. This module enables you to validate the NF, match the NF with the PO, resolve discrepancy, and approve the NF with correction documents.

To create the Nota Fiscal for PO Receiving, perform the following steps:

**Navigate** From the RMS Start Menu, select Fiscal Management, then Login of Location. The Location Login window is displayed.

1. In the Location Login window, select the store or warehouse for receiving/issuing the fiscal document. Click the Location LOV to obtain the list of stores or warehouses. Select the location, and click OK.

**Figure 3–1 Location Login Window**

2. You are returned to the RMS main screen. In Contents Of Fiscal Management, select Receiving/Issue.

In Contents Of Receiving/Issue, click Edit. The Receiving/Issue Schedule window is displayed.
3. Select the Mode from the list. For PO receiving, select **Entry**.

The other option available is **Exit**. This mode is for outbound flow.

4. The Filter section in the Receiving/Issue Schedule window displays the following:
   - **Location Type** – This field displays the information that flows from the Location Login window. The list contains Store or Warehouse.
   - **Location** – The sender/receiver location.
   - **Schedule** – Select the schedule number from the Schedule LOV or click **Add** to create a new schedule number.
   - Select the appropriate status from the list in the Status field. For PO Receiving, the status has to be **Worksheet**.

The different statuses are given below.

<table>
<thead>
<tr>
<th>Status</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Worksheet</td>
<td>Schedule is in worksheet status even if one of its component NFs is in worksheet and none of the NFs are in error status.</td>
</tr>
<tr>
<td>Validated</td>
<td>This option is displayed when all the NFs in the schedule do not have any data integrity errors.</td>
</tr>
<tr>
<td>Error</td>
<td>This option is displayed when even one NF in the schedule has incorrect information in it.</td>
</tr>
<tr>
<td>Subm. for Recv.</td>
<td>This option is displayed when all the NFs in the schedule are submitted for receiving.</td>
</tr>
<tr>
<td>In Discrepancy</td>
<td>This option is displayed when even one NF in the schedule is in the discrepant status.</td>
</tr>
<tr>
<td>Received</td>
<td>This option is displayed when the merchandise in the schedule have been received.</td>
</tr>
<tr>
<td>Receipt-Verified</td>
<td>This option is displayed when the merchandise have been verified against the schedule.</td>
</tr>
<tr>
<td>Approved</td>
<td>The status of schedule automatically changes to approved when all the NFs in that schedule are approved.</td>
</tr>
</tbody>
</table>
Enter the Start Date and the End Date in their respective fields.

5. Click Fiscal in the Receiving/Issue Schedule window. The Fiscal Docs Find window is displayed. This screen displays all the NFs linked to that schedule.

6. In the Fiscal Docs Find screen, click Add. The Fiscal Documents window is displayed.

The Fiscal Documents window is divided into three sections – Fiscal Document Details, Header Detail, and Line Item Level Detail.

### Table 3-1 (Cont.) Status Of Schedule

<table>
<thead>
<tr>
<th>Status</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Completed</td>
<td>This option is displayed when processing of all the NFs in the schedule is completed.</td>
</tr>
<tr>
<td>Post Sefaz Approve Error</td>
<td>This option is displayed when the schedule is transmitted through the internet to the SEFAZ (Secretaria da Fazenda–Brazilian Tax Authority) of the origin state of the issuer.</td>
</tr>
<tr>
<td>Financials Posted</td>
<td>This option is displayed when the schedule details are posted in the financial staging tables.</td>
</tr>
<tr>
<td></td>
<td>The schedule may have more than one NF associated with it.</td>
</tr>
</tbody>
</table>
In the Fiscal Document Details section, enter the details as given in the table.

<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Requisition Type</td>
<td>Select Purchase Order Requisition Type for the PO receiving transaction from the drop-down list.</td>
</tr>
<tr>
<td>Utilization</td>
<td>This field is enabled only when the Requisition Type is entered. Select the Utilization from the list that is specific to the PO operation.</td>
</tr>
<tr>
<td>Entry CFOP</td>
<td>This field is populated by the tax integration. The Entry CFOP is used for the fiscal bookkeeping and Public System of Digital Bookkeeping or SPED. This field is non-editable. Note: SPED (Sistema Público de Escrituração Digital) is a digital file composed of a group of bookkeeping registers of fiscal documents and other information that the fiscal authorities of Brazilian government are interested in.</td>
</tr>
<tr>
<td>NF CFOP</td>
<td>Enter the value for NF CFOP. CFOP is the Operations and Service-Providing Fiscal Code.</td>
</tr>
<tr>
<td>Fiscal No</td>
<td>Enter the fiscal number.</td>
</tr>
</tbody>
</table>
Status Contains the possible status of the NF. When you are entering the details in the system, the status of NF is Worksheet.

The NF has to be in Worksheet status to edit or cancel it.

The other statuses are as follows:

- In Discrepancy – The application displays this status, when the NF is in the discrepant status. Discrepancies can be in quantity, cost, and tax.
- Validated – The NF status changes to Validated, if there are no data integrity errors.
- Error – The application displays this status for validation related errors, errors in NF generation using the EDI file, errors in NFe transmission or TaxWeb Tax Rules call for taxes.
- Approved – Post approval.
- Received – When the merchandise in the NF is received, the status of NF changes to Received.
- Receipt Verified – This status is displayed when the merchandise has been verified against the NF.
- Completed – This status is displayed when processing of the NF is completed.
- NFe Pending – This is applicable for NFe processing only. During the NFe issuing process, when the NFe has to be approved, the status of the NF is NFe Pending.

With the fiscal document in that status, the related information is sent to the fiscal partner solution which captures the data, generates the NFe file and submits it for approval in the Brazilian Governments systems.

- Financials Posted – This is applicable when the transaction details are entered in the transaction data table after NF approval.
- Post Sefaz Approve Error – This option is displayed when the NF is transmitted through the internet to the SEFAZ (Secretaria da Fazenda–Brazilian Tax Authority) of the origin state of the issuer.

<table>
<thead>
<tr>
<th>Serial</th>
<th>Enter the serial number for the NF.</th>
</tr>
</thead>
<tbody>
<tr>
<td>Document Type</td>
<td>Select the document type for the PO from the Document Type LOV.</td>
</tr>
<tr>
<td>Mode Type</td>
<td>This field is populated from the Receiving/Issue Schedule screen. This field displays Entry for PO Receiving, and Exit for outbound operations.</td>
</tr>
<tr>
<td>Sub Serial</td>
<td>Enter the sub-serial number of the NF.</td>
</tr>
<tr>
<td>Type</td>
<td>This is an external entity type from which NF is received. You can select any one of the Type from the Type LOV. The Type LOV includes Supplier Site, Store, Warehouse, Company, Customer, Bank, Agent, Freight forwarder, Importer, Broker, Factory, Consolidator, Applicant, Consignee, Manufacturer, Distributor, Wholesaler, Expense Vendor, Import Authority, Escheat –State, Escheat-Country, External Finisher, Discharge Port, Lading Port, Entry Port, Return Center, Bill to Location, LC to Location, Routing Location, Clearing Zone.</td>
</tr>
<tr>
<td>Schedule No</td>
<td>This field is populated from the Receiving/Issue Schedule screen. It could be the number of the schedule receiving or the number of the schedule issuing.</td>
</tr>
</tbody>
</table>
7. In the Header Details section, enter the following details – Header Info, Header Taxes, Additional Info, Transportation Details, Source Details, and Destination Details.

- The Header Info Tab is shown in Figure 3–5 and the fields and description are provided in Table 3–3.

**Figure 3–5  Header Info Tab**

**Table 3–3  Fields in the Header Info Tab**

<table>
<thead>
<tr>
<th>Fields</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Totals</td>
<td>Informed and Calculated Service, Informed and Calculated Merchandise, and Informed and Calculated Total. Enter the details in each field. The Calculated Costs come from the system.</td>
</tr>
<tr>
<td>Additional Costs</td>
<td>Freight, Insurance, and Other Expenses. When processing complementary NF for Freight, only these fields are enabled.</td>
</tr>
<tr>
<td>Discounts</td>
<td>Select Percentage or Value from the Type list. Enter the value in the Value field.</td>
</tr>
<tr>
<td>Discrepancy</td>
<td>Three check boxes, one each for Cost, Quantity and Tax are present. If the NF is in cost discrepancy, then the check box for Cost is selected. Likewise for Quantity and Tax.</td>
</tr>
<tr>
<td>Dates</td>
<td>Enter the Issue date, Entry/Exit date, and the Exit Hour of the NF. The Entry/Exit date is updated to the date and time when the schedule is submitted to warehouse management system/store inventory management system for the physical receipt of merchandise.</td>
</tr>
</tbody>
</table>
The Header Taxes Tab is shown in Figure 3–6 and the fields and description are provided in Table 3–4.

**Figure 3–6  Header Taxes Tab**

![Table 3–4 Fields in the Header Taxes Tab](image)

- **Fields**
  - **Tax Code**: The tax code that are part of the Brazilian tax system are present in the list.
  - **Taxable Basis**: Enter the taxable basis.
  - **Modified Taxable Basis**: This column displays the changed/modified taxable basis. This value flows from the external tax engine.
  - **Total Tax Value**: Enter the value.

- **Description**
  - Select the tax code from the list.
  - Enter the taxable basis.
  - This column displays the changed/modified taxable basis. This value flows from the external tax engine.
  - After entering the value for one tax code, click Add to enter additional details.
  - In case, you want to delete any record, select the entry, and click Delete.

The Additional Info Tab is shown in Figure 3–7 and the fields and description are provided in Table 3–5.
Figure 3–7 Additional Info Tab

The Transportation Details Tab is shown in Figure 3–7 and the fields and description are provided in Table 3–5.

Table 3–5 Fields and Description of Additional Info Tab

<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Sender/Receiver</td>
<td>In this block, the following fields of the sender/receiver are auto populated:</td>
</tr>
<tr>
<td></td>
<td>- Address</td>
</tr>
<tr>
<td></td>
<td>- City</td>
</tr>
<tr>
<td></td>
<td>- Neighborhood</td>
</tr>
<tr>
<td></td>
<td>- ZIP</td>
</tr>
<tr>
<td></td>
<td>- State</td>
</tr>
<tr>
<td></td>
<td>These fields are taken from the Supplier/Supplier Site Address, City, and so on for a PO.</td>
</tr>
<tr>
<td>Supplier Payments</td>
<td>In this block, enter the following details for the supplier payments:</td>
</tr>
<tr>
<td></td>
<td>- Date – Date of payment</td>
</tr>
<tr>
<td></td>
<td>- Value – Amount to be paid</td>
</tr>
<tr>
<td></td>
<td>Click Add to add additional details.</td>
</tr>
<tr>
<td></td>
<td>Click Delete in case you want to delete a record.</td>
</tr>
<tr>
<td>Process</td>
<td>In this block, select the Origin from the list.</td>
</tr>
<tr>
<td></td>
<td>The Process list includes the following values:</td>
</tr>
<tr>
<td></td>
<td>- Sefaz (State Tax Authority)</td>
</tr>
<tr>
<td></td>
<td>- Federal Justice</td>
</tr>
<tr>
<td></td>
<td>- State Justice</td>
</tr>
<tr>
<td></td>
<td>- Secex/SRF – Importation Tax Authority</td>
</tr>
<tr>
<td></td>
<td>- Others</td>
</tr>
<tr>
<td></td>
<td>In the Value field, enter the value.</td>
</tr>
<tr>
<td></td>
<td>These fields meet SPED requirements.</td>
</tr>
<tr>
<td>Comments</td>
<td>You can capture comments or general information regarding the purpose behind creation of the StandAlone NF.</td>
</tr>
<tr>
<td>Reference Type</td>
<td>This field serves as a descriptor for data (that is the number/code) captured in the Reference Number field.</td>
</tr>
<tr>
<td></td>
<td>The Reference Type list includes PO, Transfer, Bill of Lading (BOL), Shipment, Allocation, Advance Shipping Notice (ASN), Sale, Return, RTV, Mastersaf Tax Rules (MRT), Other.</td>
</tr>
<tr>
<td>Reference No.</td>
<td>This field supports entry of text or alphanumeric/numeric codes of transactions that the StandAlone NF might wish to associate/reference.</td>
</tr>
</tbody>
</table>

- The Transportation Details Tab is shown in Figure 3–7 and the fields and description are provided in Table 3–5.
Figure 3–8  Transportation Details Tab

Table 3–6  Fields and Description of Transportation Details Tab

<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Type</td>
<td>You can select any one of the Type from the list.</td>
</tr>
<tr>
<td></td>
<td>The Type list includes Bank, Agent, Freight Forwarder, Importer, Broker, Factory, Consolidator, Applicant, Consignee, Manufacturer, Expense Vendor, Import Authority, Escheat-State, Escheat-Country, Other, and External Finisher. Other Type is populated if the NF is a Free Form NF.</td>
</tr>
<tr>
<td>Description</td>
<td>This field is auto populated with the description of the Type selected.</td>
</tr>
<tr>
<td>State Inscription</td>
<td>This field is auto populated based on the name or CNPJ/CPF selected if Entity in RMS is selected. Else, the field is a free form entry.</td>
</tr>
<tr>
<td>Tributary State</td>
<td>This field is auto populated based on the name or CNPJ/CPF selected if Entity in RMS is selected. Else, the field is a free form entry.</td>
</tr>
<tr>
<td>Tributary Subscription No</td>
<td>This field is auto populated based on the name or CNPJ/CPF selected if Entity in RMS is selected. Else, the field is a free form entry.</td>
</tr>
<tr>
<td>Vehicle Plate</td>
<td>This field is for SPED requirement.</td>
</tr>
<tr>
<td>Name</td>
<td>This field is auto populated based on the name or CNPJ/CPF selected if Entity in RMS is selected. Else, the field is a free form entry.</td>
</tr>
<tr>
<td>Address</td>
<td>This field is auto populated based on the name or CNPJ/CPF selected if Entity in RMS is selected. Else, the field is a free form entry.</td>
</tr>
<tr>
<td>City</td>
<td>This field is auto populated based on the name or CNPJ/CPF selected if Entity in RMS is selected. Else, the field is a free form entry.</td>
</tr>
<tr>
<td>Neighborhood</td>
<td>This field is auto populated based on the name or CNPJ/CPF selected if Entity in RMS is selected. Else, the field is a free form entry.</td>
</tr>
<tr>
<td>Country</td>
<td>This field is auto populated based on the name or CNPJ/CPF selected if Entity in RMS is selected. Else, the field is a free form entry.</td>
</tr>
<tr>
<td>Plate State</td>
<td>You can specify the field if the Entity in RMS checkbox is not selected. Else the field is dimmed.</td>
</tr>
<tr>
<td>CNPJ/CPF</td>
<td>Enter the CNPJ/CPF number. This field is free form entry if Entity in RMS is not selected.</td>
</tr>
<tr>
<td>Freight Type</td>
<td>You can either choose Cost Inclusive of Freight (CIF) and Free on Board (FOB) from the freight type list.</td>
</tr>
<tr>
<td>Qty</td>
<td>Enter the quantity of items.</td>
</tr>
</tbody>
</table>
The following fields are enabled only for StandAlone NFs:

- Description
- State Inscription
- Tributary State
- Tributary Subscription No
- Neighborhood
- Country
- Entity in RMS

8. In the Line Item Level Details section, the detailed information of the purchase order (PO) and the items are displayed.

You can populate the Detail Info section of PO in the following three ways:

- Default
- Custom
- UOM

**Note:** UOM view is available and editable only when NF is in Worksheet status.

- Click PO in the Detail Info tab of the Item Level Details section. Select the PO details from the list, or enter the PO details.

The Detail Info details is shown in Figure 3–9 and the fields and description are provided in Table 3–7.

**Figure 3–9  Detail Info Tab**
Table 3–7  Fields and Description of the Detail Info Tab

<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>DOC</td>
<td>It is a requisition number.</td>
</tr>
<tr>
<td>Unexpected Item</td>
<td>Check this field if the item does not belong to any PO.</td>
</tr>
<tr>
<td>Item</td>
<td>Enter the item or items that are part of the purchase order.</td>
</tr>
<tr>
<td>Pack Ind</td>
<td>This indicator is highlighted if the item is a pack.</td>
</tr>
<tr>
<td>Description</td>
<td>Enter the description of the item.</td>
</tr>
<tr>
<td>NF Cfop</td>
<td>This field displays the CFOP code from TaxWeb Tax Rules.</td>
</tr>
<tr>
<td>Unit</td>
<td>The number of units of the item.</td>
</tr>
<tr>
<td>Quantity</td>
<td>Enter the quantity of the item.</td>
</tr>
<tr>
<td>Unit Cost</td>
<td>The unit cost of the item.</td>
</tr>
<tr>
<td>Discount Type</td>
<td>Enter the discount type applicable.</td>
</tr>
<tr>
<td>Discount</td>
<td>Enter the discount applicable.</td>
</tr>
<tr>
<td>Total Cost</td>
<td>Enter the total cost applicable.</td>
</tr>
</tbody>
</table>

**Note:** You can also view the Unit of Measurement (UOM) type by selecting UOM from the View menu.

The Detail Info UOM View is shown in Figure 3–10 and the fields and description are provided in Table 3–8.

Figure 3–10  Detail Info UOM View

Table 3–8  Fields and Description of the Detail Info Tab UOM View

<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>PO</td>
<td>Enter the Purchase Order (PO) number.</td>
</tr>
<tr>
<td>Unexpected Item</td>
<td>Check this field if the item does not belong to any PO.</td>
</tr>
<tr>
<td>Item</td>
<td>Enter the item or items that are part of the purchase order.</td>
</tr>
<tr>
<td>Pack Ind</td>
<td>Enter the packet item indicator that are part of the purchase order.</td>
</tr>
<tr>
<td>Description</td>
<td>Enter the description of the item.</td>
</tr>
<tr>
<td>NF Cfop</td>
<td>This field displays the CFOP code from TaxWeb Tax Rules.</td>
</tr>
</tbody>
</table>
Table 3–8 (Cont.) Fields and Description of the Detail Info Tab UOM View

<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
</table>
| UOM Type            | UOM type provides an option to associate an appropriate NF based UOM to an item. Select the UOM type from the following list:  
  ■ SUOM (refers to Standard Unit Of Measurement of the item)  
  ■ Case  
  ■ Pallet |
| Unit                | The unit cost of the item. Unit displays the corresponding SUOM if user selects UOM type as SUOM, Case, or Pallet. |
| Pack Size           | Enter the pack size applicable. You are not allowed to update the pack size during NF entry. |
| UOM Quantity        | Enter the UOM quantity applicable. |
| UOM Unit Cost       | Enter the UOM unit cost applicable. |
| Total Cost          | Enter the total cost applicable. |

**Note:** You cannot modify the Item or PO details in the default view that are modified in the UOM view.

**Note:** You can search for an Item using the Vendor Product Number (VPN). See Searching using Vendor Product Number in the Fiscal Documents window for more information on searching for an Item using the VPN.

- Click the **Req. Doc.** button in the Header Details section. The Match Document window appears.

An example of the Match Document window is given below.
In the Match Document window, all the open POs of that particular supplier are displayed.

To include the PO details in the NF, do the following:

- In the Additional Filter section of the Match Documents window, you can select POs from different supplier sites of the same supplier.
  
  Click Add in the Additional Filter section of the Match Documents window to view the POs from different supplier sites of that particular supplier in the multi-record block.

- Select one or more requisition documents from the list.

- Click Add to NF. The item level information from those POs is defaulted on the NF. This saves significant data entry efforts.

9. Select the check box for the Unexpected Item to indicate any unexpected item in the NF. When this check box is selected, the PO column is disabled and the value for the PO number is set to null.

Enter the item quantity and cost. The cost and the quantity of the unexpected item is not matched with the PO.

10. Click Item. Enter the items associated with the PO. If the PO contains pack items the Pack Ind check box is selected.

---

**Note:** The Show Components, Explode, and Explode All button is enabled for pack items.

11. In the Detail Taxes tab, enter the tax details for the item.

**Table 3–9 Fields and Description of the Detail Taxes Tab**

<table>
<thead>
<tr>
<th>Fields</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Type</td>
<td>Indicates the type of tax such as ICMS, COFINS, and so on.</td>
</tr>
</tbody>
</table>
An example of the Detail Taxes tab is given in Figure 3–12.

Figure 3–12 Detail Taxes tab

<table>
<thead>
<tr>
<th>Fields</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Tax Base</td>
<td>Indicates whether the tax is value-based or percentage-based.</td>
</tr>
<tr>
<td>Tax Basis</td>
<td>The basis for calculating the taxes.</td>
</tr>
<tr>
<td>Modified Tax Basis</td>
<td>Displays the modified or changed taxable basis. The external tax engine</td>
</tr>
<tr>
<td></td>
<td>provides this basis, and this value is used for tax calculation.</td>
</tr>
<tr>
<td></td>
<td>In Brazil, some items are eligible for a tax rule that modifies the taxable</td>
</tr>
<tr>
<td></td>
<td>basis, mostly lower taxable basis. For such items, the tax rate is applied</td>
</tr>
<tr>
<td></td>
<td>on the modified taxable basis. TaxWeb Tax Rules calculates the modified</td>
</tr>
<tr>
<td></td>
<td>base and then calculates the tax values accordingly.</td>
</tr>
<tr>
<td>Tax Rate</td>
<td>The tax rate applied.</td>
</tr>
<tr>
<td>Total Value</td>
<td>The informed total value for the tax.</td>
</tr>
<tr>
<td>Legal Message</td>
<td>The legal message associated with the tax code at the line level.</td>
</tr>
</tbody>
</table>

Note: If you enter detail level taxes, you have to enter the detail level taxes for each item which are on the Item Detail grid. The Totals on the Detail Taxes tab has to match the Header tax information within the tolerance level.

12. After you have entered the relevant details, from the Options menu, select Validate. If there is no discrepancy, the status of NF changes to Validated.

The different menu items of the Options menu in the Fiscal Documents window are given below.

Table 3–10 Options Menu Items and Description

<table>
<thead>
<tr>
<th>Menu Item</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Worksheet</td>
<td>To edit the Nota Fiscal, change</td>
</tr>
<tr>
<td></td>
<td>the status of NF to worksheet.</td>
</tr>
</tbody>
</table>
### Options Menu Items and Description

<table>
<thead>
<tr>
<th>Menu Item</th>
<th>Description</th>
</tr>
</thead>
</table>
| Validate                | Use this option to validate the NF after entry. Validation process has the following steps involved:  
  - Data Integrity Validation  
  - TaxWeb Tax Rules Call for Tax Breakup  
  - Discrepancy Identification  
  For more information refer to Discrepancy Identification and Resolution Process |
| Verify Received Qty     | Use this option to review any discrepancy between the expected quantity as per the NF and the actual received quantity. This option is enabled for Inbound NFs only. |
| Cancel                  | Use this option to cancel the NFs. ORFM allows cancellation for few types of NFs only, such as the NF for RMA.                                 |
| Approve                 | Use this option to manually approve the NF. This is not applicable for inbound NFs.                                                        |
| Print Correction Docs.  | This option is enabled only if the NF had undergone discrepancy or there is a damaged or excess/less receiving.  
  This is enabled only after physical receiving.  
  Use this option to list the correction documents for that NF and print them for sending it to the supplier or for internal reference.  
  From the Options menu, select Print Correction Docs. The Print Fiscal Document window appears. This window displays the documents that are already printed and yet to be printed. |
| Error Log               | Use this option to view the error log in order to take corrective actions, if needed.  
  The error log can contain the following information:  
  - Validation related errors.  
  - Any error during the NF generation using the EDI file.  
  - Errors during NFe transmission or TaxWeb Tax Rules call for taxes. |
| Discrepancy Resolution  | Use this option to view all the discrepancies (resolved or unresolved) and resolve the unresolved discrepancies. From the Options menu, select Discrepancy Resolution to access the Discrepancy Resolution window. |

**Note:** The NFs in Submitted for Receiving status, and greater cannot be changed to Worksheet status for editing.

13. Click **OK**. You are returned to the Fiscal Docs Find window.

14. Click **OK** in the Fiscal Docs Find window. You are returned to the Receiving/Issue Schedule window.

15. In the Receiving/Issue Schedule window, from the **Options** menu, select **Sub. for Recv**. The schedule is submitted for receiving.

The different menu items on the Options menu in the Receiving/Issue Schedule window are as given below.
16. After the merchandise is received, ORFM uses the receipt updates, and the NF status is updated to **Receipt Verified**, if the received quantity is the same as the NF quantity. If there is a difference, the status changes to **Received**.

17. If the status is **Received**, from the **Options** menu in the Fiscal Documents windows, select **Verify Received Qty**. The Received Quantities window opens. Click **Verify**. The status changes to **Receipt Verified**, after reviewing the received quantity in this window.

18. After the receipt is verified, the NF status and schedule status changes to **Approved**. Upon approval, ORFM calculates the landed cost. The landed cost is determined by subtracting the recoverable taxes from the non-recoverable taxes and non-merchandise costs. The recoverable taxes includes ICMS, Programa de Integração Social (PIS), and Contribuição para Financiamento da Seguridade Social (COFINS). These three taxes are part of the unit cost. After removing the recoverable tax, add the non-recoverable taxes like Imposto sobre Produtos Industrializados (IPI), and the non-merchandise cost (such as freight insurance).

19. ORFM then publishes the receipts with the updated landed cost to RMS.

**Viewing the Error Log**

To view the error log, do the following:

**Navigate**: In the Receiving/Issue Schedule window, from the **Options** menu, select **Error Log**. The Error Log window appears.

---

**Note**: To view the error log at the NF level, in the Fiscal Documents window, from the **Options** menu, select **Error Log**.
Figure 3–13  Error Log Window

1. In the filter section of the Error Log, you can enter any or all of the details as given in the following table:

<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Schedule No</td>
<td>Enter the schedule number here.</td>
</tr>
<tr>
<td>Document No</td>
<td>Enter the number of the fiscal document.</td>
</tr>
<tr>
<td>Document Type</td>
<td>The document type list includes Purchase Order, Sell, Return Merchandise Authorization, Transfer, Return to Vendor, Stock Out, EDI Doc. Select the document type.</td>
</tr>
<tr>
<td>Error Type</td>
<td>This list contains two values: Warning and Error.</td>
</tr>
<tr>
<td>Error Date</td>
<td>Enter the date.</td>
</tr>
<tr>
<td>Error Status</td>
<td>The error status can be Open or Closed.</td>
</tr>
</tbody>
</table>

2. Click the filter button after entering the values. The multi-record block displays the records that meet the filter criteria along with the Error Message.

3. Select the error and click Fiscal Doc to see the Fiscal Documents window.

4. Click Close to exit the window.

NF Processing - Link and Delink

The Receiving/Issuing module of ORFM enables you to link/delink an existing NF to a schedule.

**Note:** You can Link and Delink the NF on schedules of “Submitted for Receiving” status.

Linking an NF to a Schedule

To link the Nota Fiscal to a schedule, perform the following steps:

1. Click Fiscal in the Receiving/Issue Schedule window. The Fiscal Docs Find window appears. This screen displays all the NFs linked to that schedule.

2. Click Link to link another NF to the schedule. The Fiscal Docs Find window appears.

3. Enter the query criteria in the Fiscal Docs Find window and execute the query. All NFs meeting the query criteria are displayed in the Fiscal Docs Find window.

Note: You can search for an item using fiscal number, or the VPN. See Searching using Vendor Product Number in the Fiscal Docs Find window for more information on searching for an Item using the VPN.

4. In the Fiscal Docs Find window, check the NF to be linked to the schedule, and click OK. The Fiscal Docs Find window displays the list of NFs linked to the schedule.

Note: Click OK + Repeat to add another NF to the schedule.

Figure 3-14 Fiscal Docs Find window - Linking an NF

5. Click Close to exit the window.

Delinking an NF and a Schedule

To delink the Nota Fiscal and the schedule, perform the following steps:


1. Click Fiscal in the Receiving/Issue Schedule window. The Fiscal Docs Find window appears. This screen displays all the NFs linked to that schedule.

2. Select the NF, and click Delink to delink the NF from the schedule. The following message is displayed:
Figure 3–15 Delinking an NF

3. Click Yes to delink the NF.

4. Click Close to exit the window. You are returned to the Receiving/Issue Schedule window.

Discrepancy Resolution

The NF processing for PO Receiving described in the section — NF Processing - PO Receiving works when there is no discrepancy. When there is a difference between the NF cost and PO Cost or NF quantity and PO Quantity, or NF tax and tax details from TaxWeb Tax Rules, the NF is said to be discrepant or in the In Discrepancy status.

Note: The discrepancy resolution and matching process does not address the identification of discount discrepancy and landed cost component discrepancy. The Nota Fiscal values for the landed cost component has to be apportioned to individual items.

The two approaches that are supported in ORFM for the resolution of discrepancies are as follows:

- Centralized Discrepancy Resolution – In the centralized discrepancy resolution process, the quantity discrepancies identified during the discrepancy identification has to be resolved before submitting the NF for receiving. The quantity discrepancy can be resolved at the receiving location or at the centralized location. However, the cost and tax discrepancy can be resolved at the central location after the physical receipt of the merchandise. The centralized location may refer to company headquarter or the regional office.

The status of NF or schedule in centralized receiving flow is as follows:

<table>
<thead>
<tr>
<th>Quantity Discrepancy</th>
<th>Cost Discrepancy</th>
<th>Tax Discrepancy</th>
<th>Status</th>
</tr>
</thead>
<tbody>
<tr>
<td>Yes</td>
<td>No</td>
<td>No</td>
<td>In Discrepancy</td>
</tr>
<tr>
<td>Yes</td>
<td>Yes</td>
<td>No</td>
<td>In Discrepancy</td>
</tr>
<tr>
<td>Yes</td>
<td>No</td>
<td>Yes</td>
<td>In Discrepancy</td>
</tr>
<tr>
<td>No</td>
<td>Yes</td>
<td>Yes</td>
<td>Validated</td>
</tr>
<tr>
<td>No</td>
<td>No</td>
<td>Yes</td>
<td>Validated</td>
</tr>
<tr>
<td>Yes</td>
<td>Yes</td>
<td>Yes</td>
<td>In Discrepancy</td>
</tr>
</tbody>
</table>

The NF status will not change to Approved unless all the discrepancies are resolved.
In addition, the Discrepancy Resolution item on the Options menu in the Fiscal Documents window is enabled till all the discrepancies are resolved. The check box in the Discrepancy section of the Header Details section is selected for the unresolved discrepancy.

- De-centralized Discrepancy Resolution – In the de-centralized discrepancy resolution approach, all the discrepancies are resolved at the location where the merchandise is to be received. The receiving location may be a warehouse or store. In this approach, the NF status is set to **In Discrepancy** if any discrepancy exists after validation.

You cannot submit the NF for receiving until all the discrepancies are resolved, and hence physical receiving before discrepancy resolution is not possible. Only after all the discrepancies are resolved, will the NF status change to Validated, and you can submit the NF for receiving.

**User Interface Indicators for Discrepancy**

The Fiscal Docs Find displays the status of NF as **In Discrepancy** as shown below:

*Figure 3–16 Fiscal Docs Find Window*

If there is quantity, cost or tax discrepancy, the Fiscal Documents window displays the status of NF as **In Discrepancy**.

*Figure 3–17 Fiscal Documents Window with NF In Discrepancy status*

In the Header area of the Fiscal Documents window, the check box is selected for the discrepancy that is present on the NF and is as shown in *Figure 3–18*. 
Centralized Resolution Discrepancy Process

In the centralized discrepancy resolution process, the quantity discrepancy is resolved at the receiving location or at the centralized location. The cost and tax discrepancies may not be resolved, but the nota fiscal will be in Validated status. The process to resolve quantity discrepancy is given below.

**Quantity Discrepancy**

In order to resolve quantity discrepancy, do the following:

1. From the **Options** menu in the Fiscal Documents window, select **Discrepancy Resolution**. The Discrepancy Resolution window appears.

As highlighted in Figure 3–19, the check box for Qty is selected to indicate quantity discrepancy.

**Note:** It is not necessary for the all the discrepancies to exist together.

2. Click **Resolve Qty** in the Discrepancy Resolution window to resolve only quantity discrepancy. The Discrepancy Resolution window displays the quantity details.
3. In the Discrepancy Resolution window, the list in the Resolution Action field has two options – System or Nota Fiscal. Select one of the options. Click Resolve Disc.

Note: Depending on the system options set, ORFM decides the action to be taken for discrepancy resolution.

For example, in case the system option is set to System, the Nota Fiscal option is disabled. You have to select System to resolve the discrepancy.

4. The message – "Selected Resolution Action will be applied to all the discrepant records. Are you sure you want to continue?" is displayed. Click Yes. You are returned to the Discrepancy Resolution window. Notice that the check box for quantity is not selected, and the Resolve Qty button is disabled as highlighted in Figure 3–21.

5. Click OK. You are returned to the Fiscal Documents window. The status of the Nota Fiscal is changed to Validated, if no other discrepancies exist.
6. In the Receiving/Issue Schedule window, from the Options menu, select Sub. for Recv.

7. The status of schedule changes from Validated to Subm. for Recv.

8. After the items are received, the status of the nota fiscal changes to Received.

9. Since there is a quantity discrepancy, you have to review the received quantities, before the nota fiscal can be approved. From the Options menu, select Verify Received Qty. The Received Quantities window appears.

**Figure 3–22 Received Quantities Window**

10. In the Received Quantities window, click Verify.

In this window, review the quantity of merchandise received. After reviewing the quantity of merchandise received, the status of the NF changes to Approved if there are no pending discrepancies to be resolved.

11. A correction document is generated, depending on what you have selected while resolving the quantity.

**Return NF and Merchandise without NF Report Generation**

Return NF and Merchandise without NF report can be generated at every NF level in the schedule. These reports are generated only if there is any return NF quantity or merchandise without NF quantity for any item on the NF.

The Return NF is sent to the supplier for the extra or damaged quantities. The cost and the tax details for the quantity of merchandise to be returned to the supplier are calculated.

To generate merchandise without NF, do the following:

1. In the Fiscal Documents window, from the Options menu, select Print Correction Docs. The Correction Documents List window opens.
The Correction Documents grid section lists all the correction document types that can be generated for the NF. The list may include the following, and depends on the corrective action taken:

- **Return NF** – To return the stock to the supplier that was either received in excess or was damaged and hence rejected by warehouse management system or store inventory management system, a Return NF is generated.

  After excess or damaged receiving, if system generates Return NF report, system also auto generates Return NF in Exit mode with the reference number of main NF.

- **Merchandise without NF** – If any item is received without mention on the NF, it is listed in the merchandise without NF report. This is an internal report that need not be sent to the supplier. Any such inventory is handled outside the system. The inventory featuring in this report is not accounted as on-hand inventory.

- **Discrepancy Report** – This document is generated when there are discrepancies. You can send the discrepancy report to correct the cost, quantity and tax discrepancies.

- **Complementary NF Request** – This document is generated when the supplier has incorrectly charged lower taxes than system calculated taxes. Print this document and send it to the supplier requesting the complementary NF with corrected taxes.

2. To print the document, select the check box for merchandise without NF.

3. Click **Print**. The merchandise without NF is printed.

### De-centralized Discrepancy Resolution Process

In the de-centralized discrepancy resolution approach, all the discrepancies are resolved at the location where the merchandise is to be received. The receiving location may be a warehouse or store.

The cost and tax discrepancy resolution processes are described below.

---

**Note:** To know more about resolving quantity discrepancy, refer to [Quantity Discrepancy](#).

---

### Cost Discrepancy

In order to resolve cost discrepancy, do the following:
1. From the **Options** menu in the Fiscal Documents window, select **Discrepancy Resolution**. The Discrepancy Resolution window is displayed.

![Discrepancy Resolution Window](image)

As shown in Figure 3–24, if there is cost, and tax discrepancy, the check boxes for Cost, and Tax are selected.

2. Click **Resolve Cost** in the Discrepancy Resolution window to resolve the discrepancy in cost.

3. The Discrepancy Resolution window displays the cost details. In this window, the list in the Resolution Action field has two options – System or Nota Fiscal. Select one of the options. Click **Resolve Disc**.

![Discrepancy Resolution Window](image)

**Note:** Depending on the system options set, ORFM decides the action to be taken for discrepancy resolution.

For example, in case the system option is set to System, the Nota Fiscal option is disabled. The list for resolution is disabled and the default method of resolution then becomes 'System'.
4. The message – "Selected Resolution Action will be applied to all the discrepant records. Are you sure you want to continue?" is displayed. Click Yes. You are returned to the Discrepancy Resolution window. Notice that the check box for Cost is not selected, and the Resolve Cost button is disabled as highlighted in Figure 3–26.

Figure 3–26  Discrepancy Resolution with Resolved Cost

5. Click OK. You are returned to the Fiscal Documents window. The status of the NF changes to Validated.

6. Click Close. You are returned to the Receiving/Issue Schedule window. From the Options menu, select Sub. for Recv.

7. After the items are received, the status of the nota fiscal changes to Received, if there are any overages/damages and under-receiving. Else, the status of NF changes to Approved.

Printing Correction Documents

If the System Option is set to System, then a correction document is generated whenever a discrepancy occurs. The NF has to be in Approved status.

1. From the Options menu in the Fiscal Documents window, select Print Correction Docs. The Corrections Document List is displayed.

   Note: The Print Correction Docs option is enabled only for approved NFs.

Figure 3–27  Corrections Document List Window

2. Select the check box for Discrepancy Report.

3. Click Print. The correction document for the cost discrepancy is printed.
**Tax Discrepancy**

In order to resolve tax discrepancy, do the following:

1. From the **Options** menu, select **Discrepancy Resolution**. The Discrepancy Resolution window is displayed.

   ![Discrepancy Resolution window with Tax Discrepancy](image)

2. Click **Resolve Tax** in the Discrepancy Resolution window. The system and informed tax are displayed in the Discrepancy Resolution window.

   The system tax includes:
   - **Base Value** – The basis for calculation of the tax
   - **Modified Base Value** – Contains the taxable basis changed by external tax engine for tax calculation. This happens when a tax rule modifies the taxable basis, mostly in the form of a lower taxable basis. It reflects the taxable basis the tax rate is actually applied on by external tax engine
   - **Value** – The total value

   The informed tax includes:
   - **Base Value** – Informed calculated basis for the tax
   - **Modified Base Value** – The changed basis, which flows from the external tax engine. This value is applicable for only certain items that are eligible for a tax rule, which modifies the basis on which the tax rate is calculated.
   - **Value** – The informed total value for the tax
3. In this Discrepancy Resolution window, click **Item Details**. The Item Tax Details is displayed in the Discrepancy Resolution window.

**Table 3–14  Item Tax Details Fields and Description**

<table>
<thead>
<tr>
<th>Fields</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Tax Code</td>
<td>The tax code returned by the external tax engine</td>
</tr>
<tr>
<td>System Taxable Base Value</td>
<td>The total basis on which the tax is calculated</td>
</tr>
<tr>
<td>System Tax Value</td>
<td>The total tax value returned calculated by the tax engine</td>
</tr>
<tr>
<td>Informed Taxable Base Value on NF</td>
<td>The total taxable basis apportioned to the line level by the application</td>
</tr>
<tr>
<td>Informed Tax Value on NF</td>
<td>The total taxable value apportioned to the line level by the application</td>
</tr>
<tr>
<td>Item Tax Details Section</td>
<td></td>
</tr>
<tr>
<td>Item</td>
<td>The merchandise number</td>
</tr>
<tr>
<td>Order No</td>
<td>The purchase order number</td>
</tr>
<tr>
<td>Base Value</td>
<td>System Tax – The basis used while calculating the tax</td>
</tr>
<tr>
<td></td>
<td>Apportioned Tax on NF – The apportioned tax basis value calculated for the fiscal line using the header tax basis values</td>
</tr>
</tbody>
</table>

**Figure 3–29  Tax Discrepancy Window**

**Figure 3–30  Item Tax Details Window**
4. In the Resolution By field, click the list, and select from resolve by either System or Nota Fiscal. Click Resolve Disc.

**Note:** Depending on the system options set, ORFM decides the action to be taken for discrepancy resolution.

For example, in case the system option is set to System, the Nota Fiscal option is disabled. The list for resolution is disabled and default method of resolution is set as 'System'.

5. The message – "Selected Resolution Action will be applied to all the discrepant records. Are you sure you want to continue?" is displayed. Click Yes. You are returned to the Discrepancy Resolution window. Click Close.

**Note:** If more than one component of the tax is in discrepant state, then the Discrepancy Resolution window displays the details of all the tax components. Follow the procedure listed in steps three to five to resolve the tax discrepancy.

In the Discrepancy Resolution window, notice that the check box for Tax is not selected, and the Resolve Tax button is disabled as highlighted in Figure 3–31. The Status of the Nota Fiscal is changed to Validated.
6. Click Close in the Discrepancy Resolution window. You are returned to the Fiscal Documents window. The status of the NF is changed to Validated.

7. Click OK in the Fiscal Documents window. The Fiscal Docs Find window appears. The status of the NF is displayed as Validated.

8. Click Close in the Fiscal Docs Find window. The Receiving/Issue Schedule window appears. From the Options menu, select Sub. for Recv.

9. After the items are received, the status of the nota fiscal changes to Received, if there are any overages/damages and under-receiving. Else, the status of NF changes to Approved.

10. After the NF is approved, a correction document or complementary NF for tax is generated, based on what you have selected while resolving the discrepancies.

**Complementary NF**

In the following scenarios, the supplier may issue an additional (complementary) NF in addition to the regular NF:

- Triangulation Purchase (additional NF from Delivery Supplier)
- Non-merchandise cost charged by a different supplier that is, partner (non-merchandise NF)
- NF for Cost Correction
- NF for Tax Correction

The complementary NF may impact the total amount payable and also the landed cost (and hence the WAC) of the item.

The utilization attributes is set up to one of the below values to differentiate the type of Complementary NF:

- Triangulation
- Non-Merchandise cost
- Cost/Tax Correction

For more information on the set up, see Fiscal Utilization Attributes Window.
Complementary NF for Triangulation

While creating the purchase order, the user can mention a supplier (referred to as the main supplier) to whom the payment is made and another supplier (a distributor or facilitator) who actually delivers the stock on behalf of the main supplier (referred to as the delivery supplier). This mechanism is referred to as the triangulation purchase.

The main supplier and the delivery supplier may be located in different states. In such cases, the state level taxes like ICMS and ICMS-ST are calculated based on the location of the delivery supplier.

In triangulation purchases, the retailer receives two NFs for the same inventory. One from the main supplier, which primarily serves as an invoice for making the payment and another from the delivery supplier, which serves as a bill of lading document. This document is referred to as the complementary NF for triangulation. Since ICMS and ICMS-ST depend on the delivery supplier’s location, they appear on the delivery supplier’s NF.

Complementary NF Processing for Triangulation

To create a complementary NF for triangulation, do the following:

Note: The retailer has to create a purchase order, and label it as triangulation.

Navigate: From the RMS Start Menu, select Fiscal Management, then select Contents Of Fiscal Management.

1. In Contents Of Fiscal Management, select Login of Location. The Location Login window appears.
2. In the Location Login window, select the store or warehouse of the main supplier. Click the Location LOV to obtain the list of stores or warehouses. Select the location and click OK.
4. In the Receiving/Issue Schedule window, click Add. A new NF is created in the Entry mode.
5. Click Fiscal in the Receiving/Issue Schedule window. The Fiscal Docs Find window appears.
6. Click Add in the Fiscal Docs Find window. The Fiscal Documents window appears. Enter the Utilization code for triangulation.
7. Enter the other values in the Fiscal Documents window. The NF is created in the Worksheet status.
8. Click OK. You are returned to the Fiscal Docs Find window. The Fiscal Docs Find window displays the NF that is created in the worksheet status.
9. Create another NF using the same process as given above. This is the complementary NF, and it has to be in the same schedule as the main NF. It should have the same item details as the main NF.
10. After creating another NF, return to the Fiscal Docs Find window, and select the first NF created for the main supplier.

*Figure 3–32 Complement Fiscal Doc Window*

12. In the Complement No column, select the complementary NF. Click Add to link this NF with the main NF.

13. Click OK to return to the main NF. From the Options menu, select Validate. The status of NF changes to Validated, if there is no discrepancy between the two NFs. You are returned to the Receiving/Issue Schedule window.

**Note:** The data integrity validation has to display an error if either of the NF is not entered in the application.

14. In the Receiving/Issue Schedule window, select the NF and submit it for receiving. From the Options menu, select Sub. for Recv.

**Complementary NF for Non-Merchandise Cost**

Complementary NF for non-merchandise cost is generated to account for the freight charges incurred during transportation of merchandise. The non-merchandise cost refers to Freight Cost, Insurance Cost, and Other Expenses. Non-merchandise cost is charged by a different supplier (or partner). In such cases, the supplier has to issue an additional NF or complementary NF in addition to the regular NF.

In Complementary NF for non-merchandise cost, NFs can have multiple main NFs or none. Once the main NFs are associated to the Complementary NF for non-merchandise cost NF, the cost components are apportioned to the items that are present in the main NF.

**Complementary NF Processing for Non-Merchandise Cost**

To do the NF Processing for non-merchandise cost, do the following:
Navigate: From the RMS Start Menu, select Fiscal Management, then select Login of Location. The Location Login window is displayed.

1. Select the location from the Location LOV in the Location Login window.
2. Click OK to exit the window.
3. From the RMS Start Menu, select Receiving/Issue. In the Contents Of Receiving/Issue, click Edit. The Receiving/Issue Schedule window is displayed.
4. Click Add in the Receiving/Issue Schedule window.
   A new schedule is created.

   **Note:** You can link the Complementary NF for Non-Merchandise Cost to a schedule. The Complementary NF for Non-Merchandise Cost can remain without a schedule.
   Multiple main NFs can be attached to one Complementary NF for Non-Merchandise Cost. However, you cannot associate the Complementary NF to any main NFs.

5. Select the new schedule and click Fiscal in the Receiving/Issue Schedule window. The Fiscal Docs Find window is displayed.
6. In the Fiscal Docs Find window, click Add.
   The Fiscal Documents window is displayed.
7. In the Fiscal Documents window, select Purchase Order as the Requisition Type from the list.
8. In the Utilization field, set the Utilization field for both Comp NF for Merchandise and Non-Merchandise.
   After you enter the Utilization as **Comp NF for Merchandise and Non-Merchandise**, in the Header Details of the Fiscal Documents window, the Service and Merchandise Cost fields are disabled. Requisition Doc button is disabled.
   The Additional Costs fields that include Freight, Insurance, and Other Expenses are enabled. In the Line Item Detail section, the fields in the Detail Info tab and Detail Taxes tab are disabled.
9. Enter the expenses incurred for freight and insurance in their respective fields. If other expenses are present, enter the details in the **Other Expenses** field.
   The **Totals** in the Header Details section is also enabled.
10. Click Complement to associate this NF with the main NF.
11. In the Fiscal Documents window, from the Options menu, click Validate.
    During the validation process, the total cost is validated. After the validation, status automatically changes to Approved.

**Complementary NF for Cost/Tax Correction**

Complementary NF for Cost/Tax is generated by the Supplier when there is additional costs to be paid by the Retailer because of some discrepancies in the original NF generated for the Purchase Order.
There can be multiple complementary NFs for cost and tax correction that correspond to one main NF. But one complementary NF cannot correspond to more than one main NF. In case of cost and tax discrepancy in one main NF, the supplier may send one complementary NF for cost correction and one complementary NF for each tax code correction; or the Supplier may send single complementary NF for the correction of cost and all the taxes.

The complementary NF for cost and tax will result in updating the cost in RMS.

**Complementary NF Processing for Cost/Tax Correction**

To do the NF Processing for cost/tax correction do the following:

**Navigate:** From the RMS Start Menu, select Fiscal Management, then select Login of Location. The Location Login window is displayed.

1. Select the location from the Location LOV in the Location Login window. Click OK to exit the window.
2. From the RMS Start Menu, select Receiving/Issue. In the Contents Of Receiving/Issue, click Edit.
   
   The Receiving/Issue Schedule window is displayed.
3. Click Add in the Receiving/Issue Schedule window.
   
   A new schedule is created.

   **Note:** You can associate only one main NF to a Complimentary NF for Cost/Tax Correction.

4. Select the new schedule and click Fiscal in the Receiving/Issue Schedule window. The Fiscal Docs Find window is displayed.
5. In the Fiscal Docs Find window, click Add. The Fiscal Documents window is displayed.
6. In the Fiscal Documents window, select Purchase Order as the Requisition Type from the list.
7. In the Utilization field, set the Utilization to Comp NF for Cost/Tax Correction.

   After you enter the Utilization as Comp NF for Cost/Tax Correction, in the Header Details of the Fiscal Documents window, the Service and Merchandise Cost fields are disabled. Requisition Doc button is disabled.

   The Additional Costs fields that include Freight, Insurance, and Other Expenses are enabled. In the Line Item Detail section, the fields in the Detail Info tab and Detail Taxes tab are disabled.
8. Enter the expenses incurred for freight and insurance in their respective fields. If other expenses are present, enter the details in the Other Expenses field.

   The Totals in the Header Details section is also enabled.
9. Click Complement to associate this NF with the main NF.
10. In the Fiscal Documents window, from the Options menu, click Validate.

   During the validation process, the total cost is validated. After the validation, status automatically changes to Approved.
Deal Income Posting

ORFM takes care of posting all finance related documents (NFs) for merchandise inventory/goods movement and finance invoicing. For Deal Income, though there is no inventory/goods movement, financial documents are generated to post the deal income to finance.

You need to define the default utilization in ORFM system options for deal NF. The Deal NF Utilization should be of requisition type PO.

Deal NFs are auto-generated and are not editable through ORFM User Interface. You can view the NF and print it if needed.

Deal Types

RMS supports the following three types of deals:

- Off-Invoice
- Fixed (Merchandise and Non-merchandise)
- Complex

RMS generates the following two types of fixed deal:

- Fixed deal with Merchandise and location information associated
- Fixed deal non-merchandise with no location and merchandise information associated

RMS deal batches generate the deal income on fixed deals in RMS staging tables, based on the income calculation and invoicing frequency.

For non-merchandise fixed deals, ORFM will always generate NF details at the Set Of Books (SOB) level.

A Complex Deal is created and approved in RMS with a Deal Income calculation frequency and an invoicing frequency. Once the Deal Income calculation frequency is met, RMS calculates the Deal Income through deal batches and stores them in Deal Income related tables. Once the invoicing frequency period for the deal is reached, RMS deal batches make this information available in the RMS staging tables to be processed by ORFM.

For a deal income processing that happens in RMS, a deal NF (approved status) is generated in ORFM after running the ‘fmdealinc’ batch.

For more information on Deal Income Batch Processing, see Oracle Retail Fiscal Management/RMS Brazil Localization Implementation Guide.
The Return to Vendor (RTV) operation is considered as the cancellation of the original purchase. The reference of the purchase NF has to be provided on the NF generated for RTV. The cost at which the merchandise are returned and the taxes are the same as mentioned in the purchase NF.

To initiate the RTV flow in ORFM, the inventory that has to be returned is picked and shipped in warehouse management system and store inventory management system. After the RTV shipment details are available in the ORFM application, it generates an outbound schedule and NF.

This chapter contains the following:

- Business Flow
- NF Processing for RTV

**Business Flow**

The process is similar for both the RTV from a store or RTV from a warehouse. The business process can include the following:

- Create an outbound NF from the shipment details.
- Enable the auto-approve parameter of the utilization code to validate and approve the NF immediately.
- For manual validation, and approval process, disable the auto-approve parameter of the utilization code. Manually edit the NF to resolve the errors that occur during the validation process.

Here, the validation process includes sending the NF to TaxWeb Tax Rules for CFOP determination. For each item being returned, the system selects the last received PO related NF for that item from the same supplier as the reference NF for the RTV NF. If the last reference NF is found, the taxes on RTV NF are copied from that NF. If the last reference NF is not found, the TaxWeb Tax Rules call returns the taxes applicable on the RTV transaction.

- After the NF is approved, print the NF, and send it along with the shipment. The inventory is updated in RMS.
NF Processing for RTV

To create a NF for RTV, do the following:

**Navigate:** From the RMS Start Menu, select Fiscal Management, then Login of Location. The Location Login window appears.

1. In the Location Login window, select the store or warehouse for receiving/issuing of the fiscal document. Click the Location LOV to obtain the list of stores or warehouses. Select the location, and click OK.


   In the Receiving/Issue Schedule window, set the Mode as Exit. Click Add to create a schedule for the RTV.

3. Click Fiscal in the Receiving/Issue Schedule window. The Fiscal Docs Find window appears.

4. Click Add. The Fiscal Documents window appears. In the Fiscal Documents window, the details of the shipment that is created in warehouse management system, and that flows to ORFM are displayed.

   In the Fiscal Documents window, the fields that are specific to RTV are covered below.

**Table 4–1 Differences in values for RTV on the Fiscal Documents window**

<table>
<thead>
<tr>
<th>Field</th>
<th>Value</th>
</tr>
</thead>
<tbody>
<tr>
<td>Fiscal Document section</td>
<td></td>
</tr>
<tr>
<td>Requisition Type</td>
<td>This field displays Return to Vendor</td>
</tr>
<tr>
<td>Utilization</td>
<td>This field displays the utilization code</td>
</tr>
<tr>
<td>Document Type</td>
<td>RTV</td>
</tr>
<tr>
<td>Mode Type</td>
<td>Exit</td>
</tr>
<tr>
<td>Header Details section</td>
<td></td>
</tr>
<tr>
<td>Transportation Details Tab</td>
<td>The Type list displays External Finisher</td>
</tr>
<tr>
<td>Line Item Details section</td>
<td></td>
</tr>
<tr>
<td>Detail Info Tab</td>
<td>RTV details are displayed in the RTV secondary tab</td>
</tr>
</tbody>
</table>

5. If the Auto Approve parameter for the utilization code is set to ‘Yes’, an automatic validation happens, and the NF is approved.

6. If the Auto Approve parameter for the utilization code is disabled, validation and approval of the NF has to be done manually.

   From the Options menu in the Fiscal Documents window, select Validate. If there are no errors, the status of NF changes to Validated.

   The NF will be in Error status, if errors occur during the validation process. You have to manually edit the NF to resolve validation errors.

7. After auto approval, or manual approval, print the schedule with the approved NF, and send it along with the shipment.

   To print the schedule, in the Receiving/Issue Schedule window, select the schedule. From the Options menu, select Print Document. The Print Fiscal Documents window appears.
8. The Filter section of the Print Fiscal Documents window displays the schedule. Select the Document Type, and click the filter button.

9. Based on the filter criteria, the records are displayed. Click Print. The PDF is printed.

10. Send the printed NF along with the shipment. The inventory is updated in the RMS.
Inventory Control

ORFM supports the following inventory functionalities:

- Transfers
- Inventory Adjustment
- Customer Delivery NF

Transfers

Transfer is the movement of merchandise from one location to another, either a warehouse or a store. When a transfer is initiated, ORFM creates and issues the related NF (based on the transfer information) for the merchandise to be transferred out. After the merchandise is shipped, the NF that was created, is matched with the related transfers in order to receive the merchandise in the receiving location.

Transfers can be of two types:

- Transfers (Regular, Intra-company and Inter-company, single-legged transfers)
- Two-legged Transfers (for finishing and repairing)

Business Flow

The NF processing flow of intra-company transfers is identical to intercompany transfers. The process flow for Transfers can be divided into the following subprocesses:

- Transfers Creation in RMS
- Transfer Shipment at Warehouse
- Transfer Receiving at Store

Transfer Creation in RMS

1. Create the transfer in RMS either manually or automatically through APIs or allocation or replenishment.

   **Note:** For information on creating transfers in RMS, see the Oracle Retail Merchandising User Guide.

2. For the manually-created transfers, enter a valid utilization code.

3. The transfer is interfaced with warehouse management system. If the transfer is initiated in warehouse management system as a stock order, it flows to RMS. If the
RMS initiated transfer is modified in warehouse management system, the modifications flows back to RMS.

**Transfer Shipment at Warehouse**

1. Create an outbound NF in ORFM after the merchandise are shipped in warehouse management system.

The NF is based on the information provided by warehouse management system, which includes the transfer cost, and other master data.

---

**Note:** For seamless NF processing, transfer information has to be available in the Oracle Retail Merchandising System (RMS) before the transfer is shipped from the shipping location.

2. The cost on the outbound NF generated is configurable based on the system option TSF_PURCHASE_PRICE. If this is set as Y, the last purchase price is the cost on the NF, else WAC if set as N.

---

**Note:** The above configuration is valid for intra company transfers only.

3. Validate this NF. This NF is sent to TaxWeb Tax Rules to retrieve the CFOP, and for each line item and tax breakup details.

4. After the CFOP and tax breakup details are retrieved, approve the NF.

5. If the Auto-Approve indicator is enabled for the Utilization Code, the NF validation and approval is automatic.

6. As the outbound NF is approved, an inbound NF is created in the background in Validated status.

7. Print the NF and send it along with the shipment. The inventory in RMS has to be updated after the outbound NF is generated and approved.

**Transfer Receiving at Store**

1. After the shipment reaches the destination, retrieve the inbound NF that is available in ORFM.

---

**Note:** Because the inbound NF is created using the outbound NF, validation exclusively for data integrity is not required. The tax breakup and CFOP information for the inbound NF is available as it is generated. The NF is created in Validated status.

2. Since the NF is in Validated status, submit the NF for receiving.

3. The NF receiving process is similar to the NF Processing for receiving except that there is no discrepancy and resolution process for transfers.
NF Processing for Transfers

Create the transfer, and set the utilization code for transfers in RMS. After the merchandise is shipped in warehouse management system, create the NF in Exit mode for the warehouse.

---

**Note:** For information about adding utilization codes for transfers, see the *Oracle RMS/ReSA Brazil Localization User Guide*.

---

To create the NF in the warehouse, do the following:

**Navigate:** From the **RMS Start Menu**, select **Fiscal Management**, then **Login of Location**. The Location Login window appears.

1. In the Location Login window, select the store/warehouse that is transferring the merchandise from the location list. Click **OK**. You are returned to the main menu.

2. From the **RMS Start Menu**, select **Fiscal Management**, then **Receiving/Issue**. In Contents Of Receiving/Issue window, click **Edit**. The Receiving/Issue Schedule window appears.

3. Select the schedule that is created in worksheet status. The Mode is **Exit**.

   ORFM creates an outbound NF based on the information that flows from warehouse management system.

4. Click **Fiscal** in the Receiving/Issue Schedule window. The Fiscal Docs Find window appears.

5. In the Fiscal Docs Find window, click **Add**. The Fiscal Document window appears.

   In the Fiscal Document window, the differences in values of the fields are as follows:

   **Table 5–1 ** *Fields and values for transfers*

<table>
<thead>
<tr>
<th>Fields</th>
<th>Values</th>
</tr>
</thead>
<tbody>
<tr>
<td>Requisition Type</td>
<td>Transfers. This field is disabled.</td>
</tr>
<tr>
<td>Mode</td>
<td>Exit</td>
</tr>
</tbody>
</table>

6. In the Fiscal Documents window, from the **Options** menu, select **Validate**. The CFOP and tax breakup is retrieved from TaxWeb Tax Rules.

   The Header Taxes details are as shown below:

   **Figure 5–1 ** *Header Taxes Tab*

   ![Image of Header Taxes Tab](image)
Transfers

The Details tab of the Fiscal Documents window displays the line item detail taxes.

**Figure 5–2  Detail Taxes Tab**

7. If the Auto-Approve indicator is enabled for the Utilization Code, the validation process needs no manual intervention.

8. Print the approved outbound NF, and send it along with the shipment. The on-hand inventory is reduced at the source warehouse.

9. As the outbound NF is approved, an inbound NF is created in the background in Validated status with a new NF number.

**Transfers at the Receiving**

1. At the receiving store, select the location from the location list in the Location Login window.

2. Validated inbound NF is generated based on the approved outbound NF for the transfer.

3. In the Receiving/Issue Schedule window, select the schedule with the inbound NF. The schedule is in Validated status.

**Figure 5–3  Receiving/Issue Schedule Window**

4. In the Receiving/Issue Schedule window, from the Options menu, select **Sub. for Recv**. The receiving process is similar to that of PO Receiving, except that there is no discrepancy identification and resolution process available for transfers.

5. As the merchandise is received, the status of NF changes to **Approved**.
Business Flow for Two-Legged Transfer

The business flow for two-legged transfer can be divided into three sub-processes as follows:

- **Transfer Creation**
- **Two-Legged Transfer Shipment**
- **Two-Legged Transfer Receiving**

**Transfer Creation**

- For two-legged transfers, create the transfer in RMS. If the transfer type is repair, the context type is Repairing. After the transfer is approved, RMS creates the second leg of the transfer as a separate transfer.
- RMS publishes the first transfer to warehouse management system or store inventory management system.
- If the context type is Repair, warehouse management system takes in the message and creates a stock order, where type = Repair.

**Note:** Stock orders where type = Repair are not selected in Wave. Repair stock orders are handled separately.

- In order to repair the merchandise, initiate a transfer in either WMS or RMS. If the transfer is used for stocking or finishing the merchandise, you must initiate the transfer in RMS only.

**Two-Legged Transfer Shipment**

- After the merchandise is sent from either the warehouse management system or the store inventory management system, the shipment information is published. ORFM uses this shipment information. A NF is generated in Exit mode.
- The transfer cost on the exit NF is equal to the weighted average cost (WAC). The taxes and CFOP are retrieved from TaxWeb Tax Rules.
- After the approved NF is printed, the shipment is ready to move out of the location. The inventory in RMS is updated as the outbound NF is approved.
- If the auto-receiver indicator is enabled at the finisher location, the in-transit quantities at the finisher location are automatically cleared. If the indicator is not enabled, RMS receives the receipt details.

It is assumed that the shipment quantity has been received at the finisher.

**Two-Legged Transfer Receiving**

- When the finished/repaired merchandise is to be returned to the supplier, a valid NF has to be generated.
- Enter the NF in the system that is generated by the repairer/finisher. This is inbound flow.
- Validate the NF for data integrity, and send it to TaxWeb Tax Rules for inbound CFOP determination. TaxWeb Tax Rules does not return the taxes, as there is no discrepancy identification done for this transaction.
- Submit the schedule containing this NF to store inventory management system or warehouse management system.
After physical receipt, ORFM uses the receipt message to process the NF. The application processes the NF as any other entry NF.

**NF Processing for Two-Legged Transfers**

For processing of two-legged transfers in ORFM, you have to create the transfer in RMS with the context type as Repairing. The warehouse management system has to publish the shipment information before the NF processing for two-legged transfer is initiated in ORFM. ORFM generates an outbound NF in Approved status, based on the shipment information provided by warehouse management system.

**NF Processing for Two-Legged Transfer Shipment**

To process NF for the two-legged transfer shipment, do the following:

**Navigate:** From the RMS Start Menu, select Fiscal Management, then Login of Location. The Location Login window appears.

1. In the Location Login window, select the store or warehouse that has to receive the shipment for repairing/finishing. Click the Location LOV to obtain the list of stores or warehouses. Select the location, and click OK.


3. Click Fiscal. The Fiscal Docs Find window appears.

4. Click OK. The Fiscal Documents window appears.

   In the Fiscal Document section, the Requisition Type is displayed as Repairing, and the Utilization field displays the values set in the RMS Transfer Maintenance screen.

   If the Auto Approve parameter is set to ‘Y’, the NF is automatically approved. Otherwise, the NF has to be manually approved.

5. The inventory in RMS is updated, after the NF is approved.
NF Processing for Two-Legged Transfer Receiving

1. In the Location Login window, select the location that receives the merchandise after the repairing/finishing work is done.

2. To receive the repaired/finished merchandise, create the schedule in worksheet status. Click Add in the Receiving/Issue Schedule window. The NF is created in Entry mode.

3. Select the schedule and click Fiscal in the Receiving/Issue Schedule window. The Fiscal Docs Find window appears.

4. Click Add. The Fiscal Documents window appears. Select Repairing from the Requisition Type LOV for this NF. Select the Utilization from the list. Set the Sub Type to External Finisher.

5. From the Options menu, select Validate. If there are no errors, the NF status changes to Validated.

6. Click OK. You are returned to the Receiving/Issue Schedule window. In the Receiving/Issue Schedule window, from the Options menu, select Sub. for Recv. The NF is submitted for receiving.

7. If there are no errors, from the Options menu, select Approve. The NF is approved, and the merchandise that has been repaired/finished can be received.

Inventory Adjustment

Inventory adjustments allows total stock-on-hand (SOH) adjustments or unavailable (un-sellable) inventory for one or more item/locations.

In Brazil:

- Stock outs can have different taxes related to the process.
- The inventory adjustments have to be linked to a NF according to the inventory adjustment reason.
- A tax call is made to TaxWeb Tax Rules for stock adjustment.

Business flow

The business flow for inventory adjustment is as follows:

- The store inventory management system, or the warehouse management system publish the details of the inventory adjustment.
- ORFM uses this information. The inventory adjustment reason code is associated with the utilization code.
- Create a NF in Exit mode or create an outbound NF.
- If the auto-approve parameter of the utilization code is set to ‘Yes’, validation, and approval of the NF happens automatically. If the auto-approve parameter of the utilization code is set to ‘No’, validate and approve the NF manually.
- After the NF has been approved, the inventory is updated in RMS.

Note: No NF is generated for positive inventory adjustments irrespective of the reason code.
**NF Processing for Inventory Adjustments**

In order to do NF processing for inventory adjustments, do the following:

1. From Fiscal Management, select **Login of Location**. The Location Login window appears. Select the store or warehouse from the Location list for which the inventory adjustments have to be made.

2. From **Fiscal Management**, select **Receiving/Issue**. Click **Edit** in the Contents Of Receiving/Issue window. The Receiving/Issue Schedule window appears.

3. Select the schedule in this window. This schedule has the outbound NF that is created based on the stock adjustment published by store inventory management system or warehouse management system. These details are published in ORFM.

4. Click **Fiscal**. The Fiscal Docs Find window appears.

5. Click **OK** in the Fiscal Docs window. The Fiscal Documents window appears.

6. In the Fiscal Documents window, from the **Options** menu, select **Validate**. The NF is validated for data integrity errors.

7. From the **Options** menu, select **Approve** to approve the NF. The inventory adjustments are made for the location after the NF is approved.

8. If the Auto-Approve indicator for the Utilization Code is set to yes, then the validation, and approval happens automatically.

---

**Customer Delivery NF**

Brazilian retailers dealing in hard lines (electronics and furniture) or selling through e-commerce channel often take customer orders and ship merchandise directly to customers. For every customer order delivery of merchandise, they issue a Customer Nota Fiscal document to accompany the delivery.

Customer Orders are generated in external Customer Order Management (COM) system. Customer Orders are based on special orders created at a physical (brick and mortar channel) store or a virtual (e-commerce channel) store. Virtual e-commerce channel stores may be defined by client as per their business requirements. For example, they may be defined based on FedEx, United Parcel Service (UPS) delivery methods.

External COM system custom interfaces customer order details to RMS for further processing. In response to this request, RMS generates a Customer Order Transfer between warehouse and virtual store. RMS publishes this customer order transfer to the warehouse management system for picking and shipping of inventory for customer delivery. The warehouse management system communicates shipment details by publishing an ASN Out to ORFM/RMS. ORFM consumes this ASN Out and auto-generates a Customer Delivery NF of sales requisition type to accompany the shipment. This NF may be printed and included in the delivery. Processing of Customer Order Shipment is similar to transfer shipment. Primary difference is that only exit NF is generated in case of Customer NF, whereas both exit and entry NFs are generated for transfer shipments.

ASN Out is custom interfaced to External COM system and the External COM further interfaces customer order fulfillment sale transaction details to Oracle Retail Sales Audit (ReSA) for special order fulfillment sale posting.
Note: Customer Delivery NF is generated in Validated status and requires manual intervention for approval, if Auto Approve Indicator for its utilization is N (No). Customer Delivery NF is validated and generated in Approved status, if Auto Approve indicator is Y (Yes).
The Return Merchandise Authorization (RMA) process occurs when the customer wants to return the merchandise without visiting the store.

In order to implement the RMA process, the fiscal management module and warehouse management system applications have to be integrated with a third-party Customer Order Management (OM) system.

Based on the information provided by the Order Management system, ORFM creates the inbound Nota Fiscal for RMA. Send this inbound Nota Fiscal to the customer authorizing the return.

After the RMA records are uploaded in the fiscal management module, the records are visible in the RMA NF Creation screen.

**Business Flow**

1. Create a schedule and select the required RMA records to create the NFs for RMA.
2. Create the NF in worksheet status, and link it to the schedule.

**Note:** The status of the RMA record is changed, and the RMA record is not available for NF generation again.

3. Validate the NF either manually or automatically. The validation depends on the auto-approve parameter for the utilization for that NF. If the Auto-approve parameter for the utilization is set to ‘y’, then the NF is validated automatically. Otherwise, the validation has to be done manually.

4. After validation, the status of NF changes to **Pending for Receiving**. The customer returns the RMA with the merchandise.
NF Processing for RMA

To process NF for RMA, do the following:

**Navigate**: From the RMS Start Menu, select Fiscal Management, then Login of Location. The Location Login window appears.

1. In the Location Login window, select the store or warehouse for receiving/issuing of the fiscal document. Click the LOV in the Location field to obtain the list of stores or warehouses. Select the location, and click OK.


3. Click Add. A new schedule is created in worksheet status.

4. Click Fiscal. In the Fiscal Docs Find window that appears, click RMA. In the RMA NF Creation window that appears, select the RMA documents that are to be added to the schedule.

5. Click Add to Schedule. The selected documents are displayed in the Fiscal Docs Find window with the status Pending for Receiving.
6. Select one of the documents and click **OK**. The Fiscal Documents window appears with all the values of that particular document.

**Figure 6–4 Fiscal Documents Window**

7. After RMA processing is complete in the Order Management System, the updates are sent by the Order Management System to the ORFM application to close the Nota Fiscal for RMA.

8. After the application receives all the Nota Fiscals in an inbound schedule for RMA, the status of the inbound schedule is changed to **Approved**.
Fiscal Documents for all the requisition types discussed in the previous chapters can be accessed using the Fiscal Docs Find window.

**Accessing Fiscal Documents**

You can access the individual NFs from the schedule screen or directly from the main menu.

To access the NF from the main menu, do the following:

*Navigate:* From the RMS Start Menu, select Fiscal Management, then Fiscal Documents. The Fiscal Docs Find window opens.

![Figure 7–1  Fiscal Docs Find Window](image)

In the Fiscal Docs Find window, the Action field has a list, which contains the following:

<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Action</td>
<td>To create a new NF, select this Action.</td>
</tr>
<tr>
<td>New</td>
<td>Only to view the NF. The NF cannot be edited when the Action is View.</td>
</tr>
<tr>
<td>Edit</td>
<td>To edit the NF, select this Action.</td>
</tr>
</tbody>
</table>
Creating a New NF

To create a new NF, do the following:

1. In the Fiscal Docs Find window, select New from the Action field, and click **OK**.
2. In the Fiscal Documents window, enter the details given in **Fields in the Fiscal Document Details Section**.
3. From the Options menu, select Validate. This will validate the details entered in the Fiscal Documents Details section.
4. Click **OK**. The Fiscal Docs Find window appears.
5. Click **Close** to exit the window. You are returned to the Fiscal Docs Find window.

---

### Table 7–1 (Cont.) Fields in the Fiscal Docs Find window

<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Fiscal No</td>
<td>Enter the fiscal number here.</td>
</tr>
<tr>
<td>Schedule No</td>
<td>Enter the schedule number in this field.</td>
</tr>
<tr>
<td>Mode Type</td>
<td>The mode type can be either Entry or Exit. Select from the list.</td>
</tr>
<tr>
<td>Document Type</td>
<td>Select the document type from the list.</td>
</tr>
<tr>
<td>Status</td>
<td>Select the status of the NF from the list.</td>
</tr>
<tr>
<td></td>
<td>The link includes: Worksheet, Validated, Error, Subm. for Recv., In Discrepancy, Approved, Pending for Receiving, Inactive, Received, NFe Pending, Receipt Verified, Cancelled, Nullified by SEFAZ, Completed, Post Sefaz Approve Error, Financials Posted.</td>
</tr>
<tr>
<td>Utilization</td>
<td>Select the Utilization from the list.</td>
</tr>
<tr>
<td>CFOP</td>
<td>Enter the CFOP number here.</td>
</tr>
<tr>
<td>NFe Access Key</td>
<td>Applicable only for NFe.</td>
</tr>
</tbody>
</table>

**Sender/Receiver Section**

<table>
<thead>
<tr>
<th>Type</th>
<th>This is external entity type from which the NF is received. The list includes Supplier, Partner, Location, Outside Location, Company, and Customer.</th>
</tr>
</thead>
<tbody>
<tr>
<td>Name</td>
<td>Enter the name of the sender/receiver</td>
</tr>
<tr>
<td>Sub Type</td>
<td>Select the value from the list.</td>
</tr>
<tr>
<td>CNPJ/CPF</td>
<td>Select the CNPJ/CPF from the list.</td>
</tr>
</tbody>
</table>

**Dates Section**

<table>
<thead>
<tr>
<th>Issue</th>
<th>Date of issue or stock receipt. Select from the date editor.</th>
</tr>
</thead>
<tbody>
<tr>
<td>Entry/Exit</td>
<td>The date the NF was entered.</td>
</tr>
<tr>
<td>Exit Hour</td>
<td>The exit time of the NF</td>
</tr>
</tbody>
</table>

**Doc Detail Section**

<table>
<thead>
<tr>
<th>Requisition Type</th>
<th>Select the Requisition Type from the list. The list includes Purchase Order, Transfer, Return to Vendor, etc.</th>
</tr>
</thead>
<tbody>
<tr>
<td>Doc</td>
<td>If the requisition type is PO, the Doc list includes the list of POs.</td>
</tr>
<tr>
<td>Item</td>
<td>Select the items on the PO.</td>
</tr>
</tbody>
</table>
Searching Fiscal Documents

To search the Fiscal Documents, do the following:

1. In the Fiscal Docs Find window, select Edit from the Action field.

2. After entering the search criteria, click Search. The Fiscal Docs Find window appears. All the NFs that meet search criteria are displayed.

3. Select the NF and click OK. The Fiscal Documents window appears. Here you can view and edit the NF details.

4. The following buttons are enabled only when the Fiscal Docs Find window is accessed through Schedule window:
   - Add – Click Add to add NF details in the Fiscal Document window.
   - RMA – Click RMA to add NF information to the schedule, when customer has returned the merchandise.
   - Link – Click Link to link an NF to a schedule.
   - Delink – Click Delink to remove an NF from a schedule.

5. Click Refresh to return to the previous window and enter the criteria again.

6. Click Close to exit the window. You are returned to the Fiscal Docs Find window.

Searching using Vendor Product Number in the Fiscal Docs Find window

To search using the Vendor Product Number (VPN) in the system, do the following:

1. In the Fiscal Docs Find window, select Edit from the Action field.

2. Click in the Item field, in the Doc Details section.

3. From the Options menu, select Item Number Type. The Item Number Find window appears. The fields and descriptions are given below:

<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Reference Item</td>
<td>The reference item ID and description.</td>
</tr>
<tr>
<td>VPN</td>
<td>The Vendor Product Number and description.</td>
</tr>
<tr>
<td>Line</td>
<td>The Line ID and description.</td>
</tr>
</tbody>
</table>
Figure 7–3  Item Number Find Window

4. Enter the VPN number. The VPN description, Line ID, and Line description fields are pre-populated.

5. Click OK. The Fiscal Docs Find window appears with the item number and description fields pre-populated.

Searching using Vendor Product Number in the Fiscal Documents window

To search using the Vendor Product Number (VPN) in the system, do the following:

1. In the Fiscal Docs Find window, click Add.

2. In the Fiscal Documents Window, enter the details in the Fiscal Documents Details section, and Header section.

3. Select Item in the Line Item Details section. From the Options menu, select Item Number Type. The Item Number Find window appears. The fields and descriptions are given below:

<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Reference Item</td>
<td>The reference item ID and description.</td>
</tr>
<tr>
<td>VPN</td>
<td>The Vendor Product Number and description.</td>
</tr>
<tr>
<td>Line</td>
<td>The Line ID and description.</td>
</tr>
<tr>
<td>Item</td>
<td>The Item ID and description.</td>
</tr>
</tbody>
</table>

4. Enter or select the VPN number. The VPN description, Line ID, and Line description fields are pre-populated.

5. Click OK. The Fiscal Documents window appears.

Note: The item number and description fields are pre-populated.
The NF-e issuer generates an electronic file with all NF information in a more detailed level than the regular NF. This file must be digitally signed to guarantee the integrity of the data and the authorship of the issuer. This electronic file is transmitted by the internet to the Secretaria da Fazenda - Brazilian Tax Authority (SEFAZ) in the origin state of the issuer. The SEFAZ provides a pre-validation of the file and returns a receiving protocol (Authorization for Use), necessary for the movement of merchandise.

The ORFM application allows the generation of NF-e by location and utilization code. A new system option is used to identify the location that issues the NF-e. NF-e is applicable only for transactions such as transfers, intercompany transfers, and RTVs.

This chapter covers the following sections:

- Configuring Location for NF-e Processing
- NF-e Processing
- Cancelling NF-e

**Configuring Location for NF-e Processing**

To configure the location for NF-e processing:

**Navigate:** From the RMS Start Menu, select Fiscal Management, then System Setup. From System Setup, select NFe Configuration.

1. In the Contents of NFe Configuration, click Edit. The NFe Configuration window appears.
2. In the NF-e Parameterization block of the window, click Add. A row is highlighted.

3. Select the Location Type from the list.

4. Select the Location from the LOV.

5. Assign the Utilization for the location. This utilization code associated to each location is the same utilization code set in system variables as default utilization for outbound transactions, such as transfers, intercompany transfers, and return to vendors (RTVs).

   **Note:** For more information on setting up the utilization code, see Chapter 2, Adding Utilization Code.

6. The location is now enabled for NF-e processing.

   The ORFM application allows the generation of NF-e by location and utilization code. A new system option is used to identify the location that issues the NF-e. NF-e is applicable only for transactions such as transfers, intercompany transfers, and RTVs.

**Viewing the NF-e Configured Locations**

1. In the Filter block of the NF-e Configuration window, select the Location Type from the list. The choices available are Store or Warehouse.

2. The Location LOV lists all the locations for the selected location type. Select the location.

   The multi-record block displays the rows for the entered store/warehouse, which are enabled for NF-e processing.

**NF-e Processing**

To initiate the NF-e processing, you need to configure the location in the NF-e Configuration window.

   **Note:** For information on enabling a location for NF-e processing, see Configuring Location for NF-e Processing.
NF-e is applicable only for transfers, intercompany transfers, and RTVs. The flow is the same as the one defined for the transfers, intercompany transfers, and RTVs. The change in process is as follows:

- Create an outbound NF.
- In the Fiscal Documents window, the document type is auto-filled with 55. If the document type is 55, it refers to NF-e.
- Once the NF-e is validated, the status of the NF-e changes to **NF-e Pending**. With the fiscal document in that status, the related information is sent to the fiscal partner solution. The fiscal partner solution captures the data, generates the NF-e file, and submits it for approval in the Government systems.

**Cancelling NF-e**

You can cancel the NF-e manually in **Error** status from the **Options** menu.

*Figure 8–2  Cancelling NF-e through Options Menu*

The justification dialog box to enter a user cancellation reason appears, when you Cancel the NF-e.
Figure 8–3  Justification Dialog Box

Note: The default message is saved in the NFE_STAGING table, if you do not enter the reason for cancellation and click OK.
The Oracle Retail Merchandising System records each transaction (such as PO, Transfers, and RTV) in a transaction table. Each transaction may post one or more transaction codes into the transaction table. ORFM offers option to map these transaction codes with the accounts payable or the general ledger accounts.

In Brazil, the postings to Account Payables (AP) may depend on the utilization code on the NF. For example, for purchases, different AP accounts may be impacted based on the utilization code on the NF. Also, the recoverable and non-recoverable taxes have to be maintained in separate accounts.

In addition, new documents like Return NF and the Correction Letter that are generated during the discrepancy resolution process, will also have to be interfaced with AP.

The ORFM application uses predefined parameters to pass the relevant values to the accounts of AP.

To enable financial integration, store the data in a specified format in ORFM.

This chapter covers the following sections:

- Business Flow
- Dynamic Segment Setup
- General Ledger (GL) Cross Reference
- Creating General Ledger Cross Reference
- Chart of Accounts

**Business Flow**

The business flow for how ORFM does the transaction data posting is given below:
The overall process is divided into the following two sub-processes:

1. Define Transaction Codes—The ORFM application provides a table with the list of predefined transaction codes used for transaction data posting. For each transaction, the transaction code, and the information that is posted vary. For different transaction type, the postings are as given below:
   - For PO Receiving the merchandise cost exclusive of taxes, recoverable taxes, non-recoverable taxes, and the non-merchandise cost exclusive of taxes are posted as a part of transaction data.
   - For Transfers, only the recoverable, and non-recoverable taxes are posted.
   - For rural producers, only the corrected NF is posted to the transaction table. The original NF is not posted.
   - For triangulation NF, the original NF along with the ICMS/ICMS-ST details based on the complementary NF are posted.

   **Note:** For the different transaction codes, refer to the RMS Implementation Guide.

2. Transaction Data Posting—The ORFM application provides a batch program to post all the approved NFs in the transaction table.

   The process is divided into the following two broad areas:
- Account Setup
- Financial Posting

Figure 9–2 displays the process flow for Account Setup.

**Figure 9–2  Process Flow for Account Setup**

- **Start**
- Chart of Account Setup
- Set of Books Setup
- Q&A account mapping
- **End**

This is a 3 step process:
1. Define COA
2. Define Accounts in the COA
3. Define Dynamic segments in the COA

Figure 9–3 displays the process flow for Financial Posting.
Dynamic Segment Setup

The Dynamic Segment Setup form is used to dynamically determine the account code by using data from the transaction level and using the same to derive the segment values for individual entity IDs.

Editing and Viewing the Dynamic Segment Configuration

To edit or view the Dynamic Segment Configuration, do the following:

1. Choose the RMS Start Menu.
2. Select Fiscal Management > Finance.
3. In the Contents of Finance, select Dynamic Segment Setup.

4. In the Contents of Dynamic Segment Setup, click Edit/View.

   The Dynamic Segment Configuration window appears.

**Figure 9–4 Dynamic Segment Configuration Window**

![Dynamic Segment Configuration Window](image)

5. Click OK to exit.

   The Contents of Dynamic Segment Configuration Setup appears.

6. Click Refresh to add new COA setup.

7. Click Add to add an Entity Type from the Entity Type list.

8. To delete the record, select the record from the multi-record block, and click Delete.

   The following message appears.

---

**Table 9–1 Dynamic Segment Configuration Fields and Description**

<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Chart of Account</td>
<td>Enter the Chart of Account ID or select from the List of Chart Accounts.</td>
</tr>
<tr>
<td>Search</td>
<td>Search for the Chart of Account ID in Edit mode.</td>
</tr>
<tr>
<td>Entity Type</td>
<td>You can select the Entity Type for which the dynamic segment values are</td>
</tr>
<tr>
<td></td>
<td>required from the list of Entity Type.</td>
</tr>
<tr>
<td></td>
<td>Following are the values displayed in the list of Entity Type:</td>
</tr>
<tr>
<td></td>
<td>- Department</td>
</tr>
<tr>
<td></td>
<td>- Class</td>
</tr>
<tr>
<td></td>
<td>- Subclass</td>
</tr>
<tr>
<td></td>
<td>- Location</td>
</tr>
<tr>
<td></td>
<td>- Transfer Entity</td>
</tr>
<tr>
<td>Entity ID</td>
<td>The Entity ID is populated based on the Entity Type selected. You can also</td>
</tr>
<tr>
<td></td>
<td>select the Entity ID for which the segment value needs to be defined from</td>
</tr>
<tr>
<td></td>
<td>the List of Values.</td>
</tr>
<tr>
<td>Segment No</td>
<td>The Segment No is populated based on the segment number in the COA that</td>
</tr>
<tr>
<td></td>
<td>holds the dynamic values based on the entity types. You can also select the</td>
</tr>
<tr>
<td></td>
<td>Segment Number from List of Segment Numbers.</td>
</tr>
<tr>
<td>Segment Value</td>
<td>The Segment Value is populated from the account setup based on the segment</td>
</tr>
<tr>
<td></td>
<td>number selected.</td>
</tr>
</tbody>
</table>
---
9. Click Yes to delete the record or, click NO to retain the record.

10. Click Cancel to undo the changes you specified in the multi-record block.

General Ledger (GL) Cross Reference

ORM maps transactions to appropriate accounts in General Ledger (GL) and Account Payables system.

Creating General Ledger Cross Reference

To create the General Ledger Cross Reference, do the following:

1. Choose the RMS Start Menu.

2. Select Fiscal Management > Finance.

3. In the Contents of Finance, select GL Cross Reference.

   The General Ledger Search window appears.

4. In the Action field, select New.

   The Set Of Books (SOB) field is enabled.

5. Enter the Set Of Books ID, or select from the List of Set of Books.

6. Click OK.

   The GL Cross Reference window appears.
**Table 9–2   GL Cross Reference Fields and Description**

<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Sequence No.</td>
<td>It is an identifier for selecting a particular cross reference setup.</td>
</tr>
<tr>
<td>Set Of Books</td>
<td>Displays the SOB ID.</td>
</tr>
<tr>
<td>Transaction Code</td>
<td>It is a unique identifier for the transaction. The description of Transaction Codes is displayed by default. You can also select the Transaction Code from the List of Transaction Codes.</td>
</tr>
<tr>
<td>Utilization</td>
<td>Utilization is displayed based on the Transaction Code selected. The description of Utilization is displayed by default. You can also select Utilization from the List of Utilizations.</td>
</tr>
<tr>
<td>Tax Code</td>
<td>The Tax Code is displayed based on the Transaction Code selected. The description of Tax Code is displayed by default. You can also select Tax Code from the List of Tax Codes.</td>
</tr>
<tr>
<td>Reason Code</td>
<td>The Reason Code is displayed based on the Transaction Code selected. The description of Reason Code is displayed by default. You can also select Reason Code from the List of Reason Codes.</td>
</tr>
<tr>
<td>Cost Component</td>
<td>Select the Cost Component from the following list:</td>
</tr>
<tr>
<td></td>
<td>- Freight</td>
</tr>
<tr>
<td></td>
<td>- Insurance</td>
</tr>
<tr>
<td></td>
<td>- Other Expenses</td>
</tr>
</tbody>
</table>

**Credit Account Section**
7. Click OK.

The General Ledger Search window appears.

8. Click Ok+Repeat.

Clears all the fields to configure a new segment setup with the dynamic attributes for a new selected SOB.

9. To delete the record, select the record from the action block, and click Delete. The Delete field is available to the user in ‘Edit Mode’ (dimmed out).

The following message is displayed.

10. Click Cancel to undo the changes you specified in the multi-record block.
Chart of Accounts

Chart of Accounts (COAs) is the grouping of data elements that define how the company’s financial statements are structured and managed. Some of the elements in the COAs include Natural Account (Assets, Liabilities, and so on), Cost Center, Company, Affiliate, Ledger, and so on. The structure of the General Ledger (GL) is based on the financial COAs.

For more information on set up of Chart of Accounts, see Release 13.2 Oracle Retail Fiscal Management/RMS Brazil Localization Implementation Guide.

Note: Only the fields that are setup in FM_TRAN_CODES table in the REF_NO fields are enabled as shown in Figure 9-5. That is, if tran_code 100 has REF_NO_1 field set as T - Only Tax code field is enabled. Other possible configurable values include, CC for Cost components, R for Reason Codes, U for Utilization Code.
The Direct NF and Free Form NF Requisition types distinguish StandAlone NFs from other NFs created within ORFM.

You can choose Direct NF Requisition type to create StandAlone NF using items, locations, and other fiscal entities (supplier, partner, finisher, transporter, and so on) that are defined in RMS.

You can choose Free Form NF Requisition type to add generic items or services that are not present in RMS to the NF, or use fiscal entities that are not defined in RMS. The Free Form NF allows you to enter a description for each item or service added to the NF.

The Source Details and Destination Details tabs in the Fiscal Documents Window are enabled only for StandAlone NFs.

The following fields are dimmed for requisition types other than Direct and Free Form NFs:

- Description
- State Inscription
- Tributary State
- Tributary Subscription No
- Neighborhood
- Country
- Entity in RMS

For more information on Transportation Details tab, see Chapter 3, "Purchase Order".

**Source Details Tab**

The Source Details is shown in Figure 10–1 and the fields and description are provided in Table 10–1.

![Figure 10–1 Source Details Tab](image_url)
<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Source Type</td>
<td>You can select any one of the Source Type from the LOV.</td>
</tr>
<tr>
<td></td>
<td>The Source Type LOV includes Agent, Applicant, Bank, Bill To Location, Broker, Clearing Zone, Consignee, Consolidator,</td>
</tr>
<tr>
<td></td>
<td>Customer, Discharge Port, Entry Port, Escheat - Country, Escheat - State, Expenses Vendor, External Finisher, Factory, Freight Forwarder,</td>
</tr>
<tr>
<td></td>
<td>Import Authority, Importer, LC To Location, Lading Port, Return Center, Routing Location, Store, Supplier Site, Warehouse.</td>
</tr>
<tr>
<td>Source Description</td>
<td>This field is auto populated with the description of the Type selected.</td>
</tr>
<tr>
<td>State Inscription</td>
<td>This field is auto populated based on the name or CNPJ/CPF selected if Entity in RMS is selected. Else, the field is a free form entry.</td>
</tr>
<tr>
<td>Tributary State</td>
<td>This field is auto populated based on the name or CNPJ/CPF selected if Entity in RMS is selected. Else, the field is a free form entry.</td>
</tr>
<tr>
<td>Tributary Subscription No</td>
<td>This field is auto populated based on the name or CNPJ/CPF selected if Entity in RMS is selected. Else, the field is a free form entry.</td>
</tr>
<tr>
<td>Name</td>
<td>This field is auto populated based on the name or CNPJ/CPF selected if Entity in RMS is selected. Else, the field is a free form entry.</td>
</tr>
<tr>
<td>Address</td>
<td>This field is auto populated based on the name or CNPJ/CPF selected if Entity in RMS is selected. Else, the field is a free form entry.</td>
</tr>
<tr>
<td>City</td>
<td>This field is auto populated based on the name or CNPJ/CPF selected if Entity in RMS is selected. Else, the field is a free form entry.</td>
</tr>
<tr>
<td>Zip</td>
<td>This field is auto populated based on the name or CNPJ/CPF selected if Entity in RMS is selected. Else, the field is a free form entry.</td>
</tr>
<tr>
<td>Neighborhood</td>
<td>This field is auto populated based on the name or CNPJ/CPF selected if Entity in RMS is selected. Else, the field is a free form entry.</td>
</tr>
<tr>
<td>State</td>
<td>You can specify the field if the Entity in RMS checkbox is not selected. Else the field is dimmed.</td>
</tr>
<tr>
<td>Country</td>
<td>This field is auto populated based on the name or CNPJ/CPF selected if Entity in RMS is selected. Else, the field is a free form entry.</td>
</tr>
<tr>
<td>CNPJ/CPF</td>
<td>Enter the CNPJ/CPF number. This field is free form entry if Entity in RMS is not selected.</td>
</tr>
<tr>
<td>Entity in RMS</td>
<td>You have an option to deselect the Entity in RMS checkbox, for an NF having requisition type Free Form NF. For a Direct NF, the Entity in</td>
</tr>
<tr>
<td></td>
<td>RMS checkbox is selected and dimmed.</td>
</tr>
</tbody>
</table>

**Note:** The Source Details tab is enabled only if Requisition Type is Direct NF or Free Form NF.
Note: It is mandatory to capture both Source and Destination Details for all StandAlone NFs.

Destination Details Tab

The Destination Details tab is shown in Figure 10–2 and the fields and description are provided in Table 10–2.

Figure 10–2 Destination Details Tab

Table 10–2 Fields and Description of Destination Details Tab

<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Destination Type</td>
<td>You can select any one of the Destination Type from the LOV. The Destination Type LOV includes store and warehouse.</td>
</tr>
<tr>
<td>Destination Description</td>
<td>This field is auto populated with the description of the Type selected.</td>
</tr>
<tr>
<td>State Inscription</td>
<td>This field is auto populated based on the name or CNPJ/CPF selected if Entity in RMS is selected. Else, the field is a free form entry.</td>
</tr>
<tr>
<td>Tributary State</td>
<td>This field is auto populated based on the name or CNPJ/CPF selected if Entity in RMS is selected. Else, the field is a free form entry.</td>
</tr>
<tr>
<td>Tributary Subscription No</td>
<td>This field is auto populated based on the name or CNPJ/CPF selected if Entity in RMS is selected. Else, the field is a free form entry.</td>
</tr>
<tr>
<td>Name</td>
<td>This field is auto populated based on the name or CNPJ/CPF selected if Entity in RMS is selected. Else, the field is a free form entry.</td>
</tr>
<tr>
<td>Address</td>
<td>This field is auto populated based on the name or CNPJ/CPF selected if Entity in RMS is selected. Else, the field is a free form entry.</td>
</tr>
<tr>
<td>City</td>
<td>This field is auto populated based on the name or CNPJ/CPF selected if Entity in RMS is selected. Else, the field is a free form entry.</td>
</tr>
<tr>
<td>Zip</td>
<td>This field is auto populated based on the name or CNPJ/CPF selected if Entity in RMS is selected. Else, the field is a free form entry.</td>
</tr>
<tr>
<td>Neighborhood</td>
<td>This field is auto populated based on the name or CNPJ/CPF selected if Entity in RMS is selected. Else, the field is a free form entry.</td>
</tr>
<tr>
<td>State</td>
<td>This field is auto populated based on the name or CNPJ/CPF selected if Entity in RMS is selected. Else, the field is a free form entry.</td>
</tr>
</tbody>
</table>
The Detail Info tab is shown in Figure 10–3 and the fields and description are provided in Table 10–3.

**Table 10–3  Fields and Description of Destination Details Tab**

<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Country</td>
<td>This field is auto populated based on the name or CNPJ/CPF selected if Entity in RMS is selected. Else, the field is a free form entry.</td>
</tr>
<tr>
<td>CNPJ/CPF</td>
<td>Enter the CNPJ/CPF number. This field is free form entry if Entity in RMS is not selected.</td>
</tr>
<tr>
<td>Entity in RMS</td>
<td>You have an option to deselect the Entity in RMS checkbox, for an NF having requisition type Free Form NF. For a Direct NF, the Entity in RMS checkbox is selected and dimmed.</td>
</tr>
</tbody>
</table>

**Note:** The Destination Details tab is enabled only if Requisition Type is Direct NF or Free Form NF.

**Detail Info Tab**

The Detail Info tab is shown in Figure 10–3 and the fields and description are provided in Table 10–3.

**Figure 10–3  Detail Info Tab for Free Form NFs**

**Table 10–3  Fields and Description of Detail Info Tab for Free Form NFs**

<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Service</td>
<td>This field is available only for Free Form NFs.</td>
</tr>
<tr>
<td>Service Code</td>
<td>This field is available only for Free form NFs and if the Service checkbox is selected.</td>
</tr>
<tr>
<td>Product Type</td>
<td>This field is available only for Free form NFs.</td>
</tr>
</tbody>
</table>

The Product Type LOV are Goods for Resale, Raw Materials, Pack Items, Processed Products, End Products, By Products, Intermediate products, Material Use and Consumption, Fixed Assets, Services, Other Supplies, Others.

For more information on Detail Info tab, see Chapter 3, "Purchase Order".